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Preface

Intended Audience
Welcome to Release 11i of the Oracle Depot Repair User Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Depot Repair

If you have never used Oracle Depot Repair, Oracle suggests you attend one or 
more of the Oracle Depot Repair training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read 
the Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Depot Repair.

■ Chapter 1, "Introduction to Oracle Depot Repair" provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions.

■ Chapter 2, "Overview of Using Oracle Depot Repair" provides instructions on 
how to access the application, and introduces the tabs available on the interface.
ix



■ Chapter 3, "Depot Repair Business Scenarios and Process Flows" provides flow 
based procedures for managing different depot repair business scenarios using 
Oracle Depot Repair.

■ Chapter 4, "Managing Depot Repair Processes" provides process-oriented, task 
based procedures for using Oracle Depot Repair to manage depot business 
activities.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and 
contains markup to facilitate access by the disabled community. Standards will 
continue to evolve over time, and Oracle Corporation is actively engaged with 
other market-leading technology vendors to address technical obstacles so that 
our documentation can be accessible to all of our customers. For additional 
information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online 
documentation, training, and support services, to increase your knowledge and 
understanding of Oracle Depot Repair.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 
Online help patches are available on MetaLink.
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Related Documentation
Oracle Depot Repair shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Depot Repair.

You can read the documents online by choosing Library from the expandable 
menu on your HTML help window, by reading from the Oracle Applications 
Document Library CD included in your media pack, or by using a Web browser 
with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Depot Repair 
(and any other Oracle Applications products). This guide also includes information 
on setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Depot Repair Implementation Guide
This implementation guide explains the tasks and considerations required to set up 
Oracle Depot Repair.

Oracle Service Concepts and Procedures Guide
Use this manual to learn more about using the Knowledge Management 
functionality in Oracle Depot Repair.

Oracle Receivables User Guide
Refer to this user guide for detailed instructions on creating customer invoices.
xi



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web 
Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is 
handled using Oracle Rapid Install, which minimizes the time to install Oracle 
Applications, the Oracle8 technology stack, and the Oracle8i Server technology 
stack by automating many of the required steps. This guide contains instructions 
for using Oracle Rapid Install and lists the tasks you need to perform to finish 
your installation. You should use this guide in conjunction with individual 
product user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given 
in the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process 
and lists database and product-specific upgrade tasks. You must be either at 
Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade 
to Release 11i. You cannot upgrade to Release 11i directly from releases prior to 
10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, 
and others. It contains how-to steps, screenshots, and other information that you 
need to run the AD utilities. This guide also provides information on 
maintaining the Oracle applications file system and database.
xii



Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle 
Applications System Administrator. It contains information on how to define 
security, customize menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status 
of your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library 
components needed to implement the Oracle Applications user interface 
described in the Oracle Applications User Interface Standards for Forms-Based 
Products. It also provides information to help you build your custom Oracle 
Forms Developer 6i forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Depot Repair. This 
manual details additional steps and setup considerations for implementing Oracle 
Depot Repair with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Depot Repair with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Depot 
Repair.
xiii



Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also 
use this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Depot Repair implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a 
specific Oracle Applications product. This information helps you convert data 
from your existing applications, integrate Oracle Applications data with 
non-Oracle applications, and write custom reports for Oracle Applications 
products. Oracle eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other 
Oracle Manufacturing applications and with your other systems. This 
documentation includes APIs and open interfaces found in Oracle 
Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other 
Oracle Manufacturing applications and with your other systems. This 
documentation includes APIs and open interfaces found in Oracle Order 
Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use 
this guide to correctly implement CRM Application Foundation.
xiv



Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Depot 
Repair and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University's online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Depot Repair working 
for you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
xv



Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction to Oracle Depot Repair

This chapter discusses the key concepts, features and process flows of Oracle Depot 
Repair. Sections in this chapter include:

■ What is Oracle Depot Repair?

■ Oracle Depot Repair Key Features

■ Business Process Flows

■ Integration with Other Oracle Modules

What is Oracle Depot Repair?
Oracle Depot Repair is part of the Oracle eBusiness Suite and offers an 
enterprise-wide solution for managing depot service repair processing. It targets the 
repair business market from simple, quick repairs, to routine maintenance. Oracle 
Depot Repair integrates with other Oracle eBusiness Suite modules to provide an 
integrated comprehensive solution for the repair service business sector.

The depot repair process includes the return of damaged and serviceable products, 
their diagnoses and repair job estimates, customer approvals and repairs 
management, and subsequent return of products to customers.   The collection of 
charges for materials, labor, and expenses for the repairs is used to invoice the 
customer.

Customers expect their repairs to be addressed quickly and seamlessly. Oracle 
Depot Repair provides end-to-end repair management functionality for service 
organizations that are committed to delivering a total service solution. 
epair 1-1



Oracle Depot Repair Key Features
Oracle Depot Repair Key Features
Oracle Depot Repair enables service organizations to meet customer expectations, 
and draw maximum benefit by improving service readiness.

The major features of Oracle Depot Repair include:

■ Customer Management

■ Service Request Management

■ Repair Type Processing

■ Repair Job Management

■ Repair Resolution Management

Customer Management
Oracle Depot Repair establishes a call center environment to improve customer 
interaction with service depots. Customers can use an access number to contact the 
relevant service depot where they can log service requests. Oracle Depot Repair also 
supports scenarios in which customers walk in at service depots for repair needs. 
The primary focus of the service representatives in the call center is to understand 
the customer’s issue and resolve it on the first call, if possible, thereby avoiding 
escalations and/or call transfers. This allows service agency experts to focus on 
their areas of expertise without the constant distraction of explaining 
well-documented issues and solutions.

Oracle Depot Repair provides service organizations with the right tools and 
knowledge for responding effectively to the repair issues raised by customers. Key 
customer management features include:

Depot Repair Workbench The Repair Order window in Oracle Depot Repair 
provides the service agent instant access to information about the customer and 
enables the agent to effectively address the needs of the customer. The customer 
Profile button enables service agents to view the number of open repair orders, 
open service requests, active contracts, and other details for a selected customer. 
The Repair Orders Search interface permits service agents to query for repair 
orders, repair order statuses, or repair jobs.

Relationship Management Oracle Depot Repair allows service agents to capture 
the contact’s relationship with others in the concerned organization, or other 
organizations, enabling service agents to engage knowledgeably with customers 
and other service agencies.
1-2 Oracle Depot Repair User Guide



Oracle Depot Repair Key Features
Customer Data Store Oracle Depot Repair enables service agencies to maintain a 
comprehensive database of all customer interactions with the agency. Oracle Depot 
Repair maintains detailed service history to trace the origin of a repair issue, and 
the follow up actions taken to solve it.

Service Request Management
Oracle Depot Repair enables service agencies to offer customers the convenience of 
accessing service through telephone or over the counter. Key service request 
management processes include:

■ Entering Service Requests

■ Searching the Knowledge Management Database

Service Request Builder Oracle Depot Repair provides an intuitive interface to 
enter new service requests and to gather appropriate data. It allows service agents 
to record customer information and attempt problem resolution to solve issues in 
the very first interaction.

Searchable Knowledge Management Database Oracle Depot Repair makes 
available a database of solutions, which the service agents can search with a view to 
solving the problem while the customer interaction is in progress. It can also be 
used to provide information such as guides, policies, procedures, and FAQs.

Repair Type Processing
Oracle Depot Repair provides repair types that enable service providers to be more 
efficient in managing the depot repair through process automation. Repair types 
help to classify the repair order and determine the repair management processes 
and logistics needed to fulfill the repair process. 

Oracle Depot Repair supports the following repair types:

■ Repair and Return

■ Loaner, Repair and Return

■ Exchange

■ Advanced Exchange

■ Loaner

■ Replacement
Introduction to Oracle Depot Repair 1-3



Oracle Depot Repair Key Features
■ Standard

■ Walk-In Repair

■ Walk-In Repair with Loaner 

Repair and Return This repair type is used when a customer returns the broken 
product to the depot for repair. After the repair is completed, the repaired product is 
returned to the customer.   This repair type requires an RMA to receive the 
customer's broken product, and a sales order to ship the repaired product and 
invoice the customer.

Loaner, Repair and Return This repair type combines two repair types, the Repair 
and Return, with the Loaner.   The loaner concept indicates that the loaner is sent to 
the customer before the receipt of the broken product.

To track the shipping and return of both the loaner and the broken item, four charge 
lines are created. This repair type requires two RMA orders and two sales orders. 

This repair type is the one to be opted when a customer uptime is critical.

Exchange This repair type represents a scenario when the depot sends out an 
exchange product to the customer after receiving the customer's broken product. 
The exchange repair type assumes no repaired product is returned to the customer. 
An internal repair order may be generated for the returned item, but this repair is 
not necessarily associated to the original exchange.

Advanced Exchange This repair type is the same as the exchange repair type 
except that the product may be sent out before the customer's product is received by 
the service organization.

Loaner This repair type is used when a product is sent out to the customer solely 
for the purpose of renting. This repair type requires a sales order to ship out the 
loaner product to the customer and to create an invoice, and an RMA order to track 
the return of the loaner product. A deposit and return due date may be required. No 
repairs are expected from a loaner repair type.

Replacement A replacement repair type refers to a scenario when the depot sends 
out a product to the customer and no return is required. In this scenario, the service 
provider sends the customer a product to replace the customer's product. The 
service organization may link the replacement product to the original product in the 
installed base, and change the status of the replaced product to indicate that it is out 
of service and replaced with the new item.
1-4 Oracle Depot Repair User Guide



Oracle Depot Repair Key Features
Standard This repair type is selected when the service agent is uncertain about the 
customer’s needs. This repair type is flexible however, and requires the manual 
creation of RMAs and sales orders.

Walk-In Repair This repair type is selected when the customer delivers a damaged 
product at the depot, and the product is returned to the customer after repair. This 
scenario is also used to process unplanned returns. Walk-In Repair behaves similar 
to Return and Repair with the exception that the Walk-In Repair repair type is 
seeded with Tasks as its Repair Mode.

Walk-In Repair with Loaner This repair type is the same as Walk-In Repair, except 
that a loaner product is provided to the customer to bridge the gap while the 
damaged product is being repaired. Walk-In Repair with Loaner is similar to 
Loaner, Repair and Return with the exception that Walk-In Repair with Loaner is 
seeded with Tasks as Repair Mode.

Repair Job Management
Either Oracle WIP (Work in Process) or Oracle Tasks is used to manage repair jobs. 
WIP mode is recommended for use when the repair jobs require a series of 
sequential steps and materials management. Tasks mode is recommended for use 
when the repairs require minimal steps that are not necessarily completed in 
sequence. Both of these repair modes are implemented and managed using separate 
tabs in the Oracle Depot Repair user interface. The WIP mode leverages the costing 
of items through Oracle Costing, while Tasks mode does not integrate with Oracle 
Costing.

The WIP or Tasks mode is associated to repair types during implementation. 
Though a service organization can have different repair types associated with 
different repair modes, it is recommended that a service organization select only 
one repair mode for all repair types to enhance usability.

Repair Resolution Management
Oracle Depot Repair improves operational efficiency by providing the following 
key repair resolution management features:

■ Repair job search functionality 

■ Process automation based on repair type; auto-creation of charge lines

■ Estimate creation and approval

■ Leveraging of the depot knowledge base throughout repair processing
Introduction to Oracle Depot Repair 1-5



Business Process Flows
■ Repair job creation and release to shop floor

■ Flexible options for receiving products, and shipping items

■ Installed base validation of products enables checking for product warranties 
and contract entitlements

■ Invoicing of final charges

Business Process Flows
Oracle Depot Repair supports the following business process flows:

■ Logistics and Maintenance with Call Center Facility

■ Logistics and Maintenance without Call Center Facility

■ Internal Repairs

Either Oracle WIP or Oracle Tasks can be used to manage the repair process. Based 
on your choice, the repair order repair type determines which repair management 
process is to be used.

Logistics and Maintenance with Call Center Facility
This business flow starts with a service request, where the problem is recorded by a 
call center service agent. If the service agent cannot resolve the problem using 
information in the knowledge base, the service request is referred to a depot repair 
agent. The depot agent then creates a repair order and an estimate (if required), and 
seeks approval from the customer for further processing.

Depending on the repair type, the depot agent completes the different RMA and 
Sales Order lines to facilitate the completion of the repair process. The repair mode 
(associated to the repair type) determines whether Oracle WIP or Oracle Tasks will 
be used to manage the repair job. After the repairs are completed, the repaired 
product is shipped back to the customer. The material, labor, and expenses 
consumed in the repair are captured as charges and are interfaced to Oracle Order 
Management for invoicing.

Logistics and Maintenance without Call Center Facility
This process is similar to the Call Center, Logistics, and Maintenance business 
process except that a call center is not involved. 
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This process can be used for businesses that do not incorporate a call center facility, 
but require their customers to send back serviceable products to a depot. 

Internal Repairs
You may need to refurbish products already owned by your organization, or repair 
a product that your organization took possession of, through a field service agent 
instead of against an RMA. Oracle Depot Repair allows you to process internal 
repairs in such cases. The customer is indicated as an internal party in the 
corresponding service request. RMAs and Sales Orders are not required to process 
internal repairs. This is under the assumption that items already exist in a 
subinventory within the organization, allowing you to create repair jobs.

Integration with Other Oracle Modules
Oracle Depot Repair integrates with the following Oracle modules:

Assignment Manager 
Oracle Assignment Manager is used by the Depot Planner to schedule technicians 
to all open and planned repair tasks. The module permits the planner to use the 
Assignment Manager in an assisted or unassisted mode. See Oracle CRM Foundation 
Users Guide for additional information related to this topic. 

Bills of Material
Bills of Material store lists of items that are associated with a parent item, and 
information about how each item is related to its parent. Oracle Depot Repair uses 
Oracle Bills of Material to create repair routers that will be used for a submitted 
WIP repair job, and to create a bill of materials for a product that is linked to a 
repair router.

Charges
Using the Charges module, a service organization can bill customers for services 
provided in response to support service requests, field service requests, and depot 
repairs. Charges also creates a return material authorization (RMA) to return a 
defective product for repair, loan, or replacement. Returns from a customer occur 
for a variety of reasons including damage, shipment error, and repair. With the 
Charges capability of processing return material, you can manage customer 
expectations while controlling inventory receipts and processing customer credit. 
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Oracle Depot Repair summons Charges APIs to auto create the charge lines once the 
repair type has been determined.

Contracts (Contracts Core and Service Contracts)
Depot Repair integrates with Oracle Service Contracts to manage service contracts 
associated with a customer’s install base product. Oracle Service Contracts holds all 
service contracts centrally; warranties, extended warranties or complex service 
agreements, providing the service provider visibility to all service entitlement 
information. It leverages functionality provided in Oracle Contracts Core to support 
common contract management activities such as contract renewal, versioning, 
article management, and change management.

Counters
Counter events and alerts provide a valuable tool to track critical service events that 
may affect a customer or products in the install base. Oracle Depot Repair uses the 
Counters module to update product counters periodically, whenever a Depot 
Technician performs work on the product, and saves it in the install base record. 
The Oracle Counters module also permits a service provider to set up logical or 
derived counters that utilize formulas that incorporate calendar dates, time, and 
cycle counts to trigger an event, such as a warranty or service contract expiration, or 
to alert the service provider when a scheduled preventive maintenance must be 
performed on a customer’s install base product. Alerts may be sent via e-mail 
notification system to inform service personnel about warranty or service contract 
expiration, or about a preventive maintenance requirement that is due.

Customer Care (Customer Profile)
The Customer Profile summarizes customer information and indicates if a customer 
is critical. It may provide information such as the number of open service requests. 
The profile entries are setup by a system administrator, and contain a set of 
predefined checks. These checks can be configured. The Customer Profile engine 
displays these check results. Depot Repair uses this functionality for customer 
management.

Field Service
When an organization sells a product to a customer, service contracts or warranties 
are often offered to the customer. Most companies offer on-site support for failures 
of the product. This is where field service is significant. After the customer reports 
the problem, the field service organization has to determine who should visit the 
customer; when, and what parts are needed to solve the problem. If a repair cannot 
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be completed on-site, the repair may need to be transferred to the depot for 
completion.

General Ledger
Oracle Depot Repair integrates with Oracle General Ledger to provide the 
functionality of recording and tracking all costs associated with every Depot Repair 
WIP repair job, and of creating general ledger accounts.

HRMS
Oracle Depot Repair uses the Oracle HRMS module to define employees and 
locations where you ship, deliver internally, or bill the goods and services that are 
ordered.

Install Base
Oracle Install Base is a repository that keeps track of all installed customer products. 
Install base maintains and updates each product record to reflect the most current 
configuration. Service organizations must rely heavily on their install base to 
provide accurate customer and product information. The install base permits quick 
access to all product records and information. Oracle Depot Repair leverages this 
information to expedite the repair process when repairs involve incompatibility, 
configuration, revision, or counter history issues. Oracle Depot Repair integrates 
with Oracle Install Base to facilitate accurate recording of all part and serial 
numbers that are moved in and out of a customer product during its life cycle. It 
retrieves all service contracts and warranties associated with an Install Base 
serialized product or component. Depending on the definition of Install Base 
transaction sub-types, the location and instance ownership information gets 
updated by the Charges APIs.

Inventory
Oracle Depot repair uses the Oracle Inventory module to manage product and spare 
parts inventory.

JTF Notes
A note records descriptive information that has been generated by users about 
business transactions so that it may be referenced. Oracle Depot Repair uses the JTF 
notes module to access the comment log that relates to a specific transaction. The 
Notes module creates and passes information to all other Oracle CRM Applications. 
Upon transmission and receipt of a note, an alert is automatically sent to the Depot 
Repair module to signal that a new note is present. Service employees can now pass 
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valuable information that may influence the repair process. The notes module 
permits users to post both public or private notes, where public notes may be 
published to a web site, while private notes are only accessible to employees that 
work inside the service organization.

Knowledge Management
Knowledge Management is an Oracle Service Core module that provides an open 
architecture repository to store technical information or solution sets. Service agents 
and technicians can retrieve this information to find a quick resolution to service 
issues being reported by customers, or for assistance in an inspection or product 
diagnosis. Knowledge Management provides a security feature that will permit 
only users with specific responsibility to contribute new information to the 
constantly enriched active database.

Oracle Depot Repair uses the Knowledge Management Search Engine to find the 
best possible solutions to resolve service issues. Agents can access the knowledge 
repository from the service request or the repair order. You can search for solutions 
by entering a service code or keyword string to query on statements linked to a 
symptom, cause, action, or fact solution set. A solution set may also include a task 
template or set of objects that can be used to automate or expedite the repair setup 
process.

Order Management
Order Management is the ERP module used by Depot Repair to create RMA and 
Sales Orders, validate customer accounts, and invoice customers for repairs.

Pricing
Oracle Depot Repair integrates with Oracle Pricing to provide an advanced, highly 
flexible pricing engine that executes pricing and promotional calculations. It allows 
Oracle Depot Repair to view and select a Price List while charging a repair, and 
while receiving or shipping a product.

Purchasing
Oracle Depot Repair’s integration with the Oracle Purchasing module is supplied 
by Oracle WIP. Oracle WIP uses the Purchasing module to perform outside 
processing of a repair from the WIP Router.
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Receivables
Oracle Receivables is the ERP module that Oracle Depot Repair integrates with to 
track and maintain customer information such as customer name, account, 
customer contacts, and location.

Resource Manager 
Oracle Resource Manager is used by Oracle Depot Repair to manage employees. 
The Resource Manager permits a user to import employees and non-employees 
from HRMS into the resource module.   Resources can be set up and managed as 
individual resources, or as a team or group, and assigned roles and skill sets to 
distinguish their qualifications. See the Oracle CRM Foundation Users Guide for 
additional information related to this topic.

Scheduler
Oracle Scheduler enables optimal scheduling of tasks and trips for field service 
business needs. While the Assignment Manager searches for qualified resources to 
complete a field service task (based upon selection criteria set within the 
Assignment Manager), these qualified resources are interfaced to the Oracle 
Scheduler to make the actual assignments based upon pre-defined constraints. The 
Scheduler uses the Assignment Manager user interface to schedule Field Service 
tasks.

Support (Service Request)
Service agents typically log a Support Service Request to record a service issue that 
is being reported by a customer. Oracle Depot Repair invokes Oracle Service 
Request APIs to auto create the service request after the repair order header is 
created. The Service Request APIs populate the service request number into the 
Repair Order Header to permanently link the two source documents with an 
internal form identity. Depot business flows always start with the creation of a 
service request.

Task Manager
Task Manager is an Oracle eBusiness Suite core module used by Oracle Depot 
Repair to facilitate repair management. The Tasks model leverages the core 
functionality provided in Oracle Depot Repair by its integration with Resource 
Manager, Assignment Manager, and Calendars. Tasks provide an alternate repair 
process that is intended to manage simple repair work that does not require 
extensive tracking or management processes. After a task is completed, the 
technician uses the Depot Repair Report to log the Material, Labor, and Expense 
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transactions. See Oracle CRM Foundation Users Guide for additional information 
related to this topic.

Work in Process
Oracle Work in Process (WIP) is the ERP module used by Oracle Depot Repair to 
facilitate the repair of broken products. The Work in Process module permits 
assignment of resources, material, and outside processing, and a WIP summary 
report that tracks the costs associated with a completed WIP repair job. A WIP job 
can be submitted with or without an assigned router.
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Overview of Using Oracle Depot Repair

This chapter provides an overview of the user interface and the major tasks you can 
perform using Oracle Depot Repair. Sections in this chapter include:

■ Accessing Oracle Depot Repair

■ The Depot Repair Workbench

■ The Service Request Information Block

■ The Repair Order Information Block

■ Tabs in the Repair Orders Window

■ Repair Orders Window Tools Menu

■ Repair Jobs Search Window

■ Submit Repair Jobs Window

Accessing Oracle Depot Repair
At the core of Oracle Depot Repair is the Depot Repair workbench that provides 
service agents with instant access to customer and repair order information. A 
number of tabs accessible from the Depot Repair workbench present information 
about the customer, the service request, and the service history of the product. 
Others allow processing of transactions such as receipt or shipment, and creation 
and processing of repair jobs and tasks. The Depot Repair workbench also provides 
access to the Knowledge Base.

Use the following procedure to access the Depot Repair workbench:
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Prerequisites: 
You must have obtained the navigation path to Oracle Applications, and a 
registered and approved login to Oracle Depot Repair from your System 
Administrator.

Login: 
Use your FORMS login page to login to Oracle Depot Repair.

Procedure:
1. Log in to Oracle Applications.

2. Select the Depot Repair Super User responsibility.

The Navigator window appears.

3. Use the following navigation path to open the Repair Order Search window:

Depot Repair > Repair Order

This launches the Repair Orders Search window where you can retrieve a 
specific repair order by entering required criteria, and clicking Search.

4. Click New on the Repair Orders Search window to open the Repair Orders 
window. This window serves as the Depot Repair workbench.

The Depot Repair Workbench
Using the Depot Repair workbench, you can perform all depot repair functions 
including repair order creation, status monitoring, receiving, and shipping. From 
the workbench, you can create repair orders that are used to track the activities on 
customer or vendor products returned to depot repair, for repair, upgrade, or 
overhaul.

The Depot Repair workbench provides integration with Oracle eBusiness Suite 
modules and components, such as Notes, Charges, Knowledge Base, Install Base, 
WIP (Work in Process), BOM (Bills of Material), General Ledger, Inventory, 
Shipping, and Receiving.

Note: You can also open the Depot Repair workbench using the 
Service Request Quick Menu.
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Service organizations can start their depot business process from this workbench. 
The service agent enters the customer and product information, and the workbench 
automatically validates the customer and product in the Install Base. 

From the Depot Repair workbench, you can:

■ Create new customers

■ Review your customer profiles

■ Auto-create service request and charge lines based on the repair type selected

■ Access Shipping and Receiving user interfaces

■ Access WIP or Tasks for repairs management

For more information on the Depot Repair workbench user interface, see:

■ The Service Request Information Block

■ The Repair Order Information Block

■ Tabs in the Repair Order Window
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The Service Request Information Block
You can enter and view customer information in the Service Request Information 
block. The Service Request Information block includes the following fields and 
buttons:

Customer Information Fields
■ Customer Type: In the Customer Type field, select the caller type from the List 

of Values.

■ Customer: Select the customer name from the List of Values. The customer can 
also be the internal party. Products are validated against the party ID to 
facilitate repair of internally owned products.

■ Account: Customer account number.

■ Phone: Customer’s contact telephone number.

■ Ship-To: The customer’s ship-to address.

■ Bill-To: The customer’s bill-to address.

Contact Information Fields
■ Contact Type: Choose this value from the dropdown list.

Note that this field value is not mandatory. If you do not want to enter any 
contact information, do not enter any value in this field, and the remaining 
contact information fields (listed below) will be disabled.

■ Contact: Contact’s name (customer account validation is required). You can use 
the List of Values defined by your organization at Oracle Depot Repair setup.

■ Relationship: Specifies the contact’s relationship with the customer, such as 
Associate of, Child of, and Benefactor of. Select this value from the LOV.

■ Contact ID: Contact’s identification number.

Note: The Bill-To and Ship-To addresses will always default to the 
primary bill-to and ship-to addresses of the customer party, even if 
you select a primary address for the Install Base instance.

Also, the List of Values for the Bill-to and Ship-to fields will contain 
only the bill-to and ship-to addresses of the customer party. They 
will not contain the addresses of the Contact even if one is selected.
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■ Phone: Contact’s telephone number.

Product Information Fields:
■ Installed Products Only checkbox: Selecting this checkbox will validate the 

product against the Install Base.

■ Product: Using the List of Values (LOV), enter the Part Number of the product 
for which service is being requested.

■ Revision: The Revision field displays the product revision residing in the Install 
Base record.

■ IB Ref Num: This field represents the Install Base Reference Number of the 
product, and applies only to products that have an install base instance. If you 
choose to enter the Install Base Reference Number for a product first, the 
Product field will be automatically populated when you select the Reference 
Number from the list of values.

■ Serial Num: If the product is serialized, enter the serial number of the product 
using the list of values. If you choose to enter the product’s Serial Number first, 
the Product field will be automatically populated when you select the Serial 
Number from the list of values.

■ Opened: The system displays the date when the request was opened.

■ Closed: The system displays the date when the request was closed.

Request Information Fields
■ Request Num: In the Request Num field, the system displays the system 

generated service request number.

■ Summary: Enter a brief description for the request in the Summary field. The 
Summary field is a text string field and is classified as a Note.

■ Request Type: Select the Request Type from the List of Values defined by your 
organization.

■ Severity: Choose a value from your organization defined list of values to assign 
a severity to the request. Default values can be set up for request severities.

■ Status: The status field defaults to Open when creating a new request.

■ SR Owner: Assign a service request owner using the List of Values. The owners 
are defined in Resource Manager, and you can set default values.
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Buttons
New Contact: To create a new customer contact, click the New Contact button.

The Repair Order Information Block
The Repair Order Information block displays the following fields:

■ Repair Num: The Repair Number field is a read only field and displays the 
system generated Repair Order Number.

■ Repair Type: The Repair Type field is a mandatory field and is part of the Repair 
Order line that contains an LOV lookup table of the user-defined Repair Types. 
Each repair type is supported by a workflow to automate the depot business 
process. See Repair Type Processing.

■ Product: The system populates this field with the product selected in the 
Service Request Information block.

■ Product Description: The Product Description field is populated automatically 
with the description of the product once the product is entered.

■ UOM (Unit of Measure): The system populates the UOM field once the product 
is entered.

■ Qty (Quantity): If a serial number is entered, then the quantity automatically 
defaults to 1.

■ Repair Status:  Repair order status. See Revising a Repair Order and Obtaining 
Customer Approval for more information.

■ Estimate Approved: This field displays the associated estimate status. Estimate 
statuses in Oracle Depot Repair include the following:

■ New: An estimate with no information entered.

■ Drafted: An estimate with information, but not ready to reveal to customer.

■ Bid: An estimate awaiting customer approval.

■ Accepted: An estimate approved by customer.

■ Rejected: An estimate not approved by customer.

■ Cancelled: An estimate that has been cancelled.
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Tabs in the Repair Orders Window
The Depot Repair workbench design provides the required windows needed to 
operate a depot repair business process. The workbench design streamlines the 
entire business process by minimizing data entry and the number of clicks needed 
to complete a business process.

The following tabs can be accessed from the Repair Orders window:

■ Details

■ Receive/Ship

■ Repair Estimate

■ Repair Jobs

■ Repair Tasks

■ Activity

■ Service History

■ Product Coverage

Details Tab
The Details tab presents the following fields and functionality:

■ Repair Num: The Repair Number field is a read only field and displays the 
system generated Repair Order Number.

■ Product: The system populates this field with the product selected in the 
Service Request Information block. If multiple repair orders have already been 
created associated with a single service request, this field dispalys the product 
in the repair order line selected in the Repair Order Information block.

■ Revision: The Revision Number field displays the product revision residing in 
the Install Base record.

■ IB Ref Num: This field represents the Install Base Reference Number of the 
product, and applies only to products that have an install base instance.

■ Serial Num: This field displays the Serial Number of the item for which repair is 
requested.

■ Lot Num: The Lot Number field displays the product lot number residing in the 
Install Base record.
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■ Installed Site: The (current) location identifier for the Install Base product.

■ Promise Date: In the Promise Date field, enter the date within which the 
product repair should be completed. This date is a prediction only, and is 
derived once the depot owner has reviewed the activities and commitments of 
the depot.

■ Date Created: The Date Created field is a read only field and displays the 
system generated date and time stamp when the Repair Order is created.

■ Date Closed: The Date Closed field is a read only field and displays the system 
generated date and time stamp when the Repair Order status is set to closed.

■ Repair Owner: In the Owner filed, select a name from the list of depot resources 
that will be responsible for execution and completion of the repair.

■ Currency: Displays the functional currency of the repair organization. Example: 
USD.

■ Repair Mode: Repair Mode field is populated with the value of either WIP or 
Tasks based on the Repair Type selected.

Checkboxes:
■ Estimate Approval Required: The Estimate Approval Required checkbox is 

used to force an approval step after a repair estimate or diagnosis is performed, 
requiring the customer to approve the repair order before the Depot can 
proceed with the repair.

■ Automatically Enter and Book RMA: The Automatically Enter and Book RMA 
checkbox is checked or unchecked by default based on setup of the repair type 
corresponding to the repair order. When a repair order is created with this 
checkbox selected, an RMA line is entered and booked automatically. You can 
still manually override default for individual repair orders.

Buttons
■ View IB Config...: An agent can view the product details contained in the Install 

Base record by clicking the View Configuration button. This launches the Install 
Base HTML window that displays the most recent product configuration, and 
revision status. The depot can make use of this information when attempting to 
troubleshoot, upgrade, or repair the product. 

■ Update Counters: The Update Counters button opens the Counters Update 
window. In the Counters Update window, repair technicians can update the 
present counters that are associated to a product. 
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■ Update RO Status: The Update Status button opens the Update Status window 
where you can change the status of a repair order to Open, On-Hold, or Close.

■ Notes: The Notes button opens the Notes window. You can use the Notes 
window to record and share relevant information about customers and repair 
processes.

The Service Request radio button provides a filter that only permits the user to 
view notes that were created in the Service Request window. The Depot Repair 
radio button provides a filter that only permits the user to view notes that were 
created in the Repair Order window.

Receive/Ship Tab
You can use the Receive/Ship tab to process a receiving or shipping transaction.

The depot agent can perform the following tasks using the Receive/Ship tab:

■ Create and view RMA/Sales Order charge lines that are linked to a selected 
Depot Repair Order.

■ Edit or Save an existing charge line.

■ Book an RMA or Sales Order.

■ Release a Sales Order for picking.

■ Receive a returned product and move it to a sub-inventory.

■ Ship or issue a repaired or loaner product.

In the Receive/Ship tab, you access the following processing options:

■ Action Type: In the Action Type field, select one of the following:

■ RMA option to receive customer or vendor products.

■ Ship option to ship products to customers or vendors.

■ Action Code: In the Action Code field, select one of the following:

■ Customer code if the product belongs to the customer.

■ Loaner option if the product is on loan to the customer.

■ Exchange option if the product is an exchange.

■ Txn Billing Type: Select the relevant transaction billing type (example, Material 
Transfer) in this field.
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■ Order Num: The Order Number field displays the RMA/Sales Order number 
returned by Oracle Order Management.

■ Status: The Status field displays the status of the active Order Management 
order number. The status can be Created, Entered, Booked, Released, Received, 
Shipped, or Issued.

■ Product: In the Product field, select the product item number from the List of 
Values.

■ UOM: Product’s Unit of Measure.

■ Qty: In the Quantity field, enter the product quantity.

■ Price List: In the Price List field, select an Order Management Price List to price 
the Charge line.

■ Price: In the Price field, select a price from the price list for the Charge line.

■ Revision: The Revision Number field displays the product revision residing in 
the Install Base record.

■ Serial Num: In the Serial Num field, select the Install Base Product's serial 
number. If the item is not Install Base tracked, then you can enter a serial 
number as free form text.

Note: The Serial Num field value may or may not be mandatory depending 
upon profile option set up during implementation. If the setup is such that the 
Serial Number field is not mandatory, you will not be able to automate the 
shipping of the sales order directly from the Depot Repair Workbench. Rather, 
you will need to launch the Shipping forms and enter the serial number before 
shipping the item. If the item on the Receive/Ship line is serialized, the Ship 
checkbox on the Receive/Ship tab will be disabled if no serial number has been 
entered. You can enter a Serial Number value manually, even if the Serial 
Number is not contained in the field List of Values. Note that after a 
Receive/Ship line has been interfaced to Order Management, that line 
(including the serial number field) cannot be updated. 

■ Lot Num: The Lot Number field displays the product lot number residing in the 
Install Base record.

■ Sub-Inventory: In the Sub-Inventory field, select a sub-inventory location to 
place or pick a product.

■ IB Ref Num: This field represents the Install Base Reference Number (Instance 
Number) of the item being transacted. The field is auto-populated when the 
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item transaction is validated against the Install Base (Install Base checkbox must 
be selected). 

■ Return Reason: Using the List of Values, enter a reason for returning the item 
using the List of Values.

■ Return by Date: Date within which the item is to be returned.

■ Contract: The default Contract Number that applies to the charge lines.

■ PO Number: Enter the Purchase Order number corresponding to the order line 
in this field. This field value is not mandatory.

■ (Addresses) Bill-To: The customer’s Bill-To address.

■ (Addresses) Ship-To: The customer’s Ship-To address.

■ Product Description: The description of the product.

Checkboxes
■ Process Txn: Selecting this checkbox processes the corresponding transaction. 

You can then select the Interface to OM, Book Order, Release Order, or Ship 
Order checkbox to process the transaction as is applicable.

■ Automate order processing steps through: This checkbox is checked or 
unchecked by default based on setup of the associated repair type. The selection 
of this checkbox will automate order processing steps through selected options 
for repair order shipping lines. If this checkbox is selected, the selected radio 
button options decide the default option for the repair order shipping line. Note 
that the shipping line is always only entered regardless of what is defaulted. For 
individual repair orders, you can manually override the default selection of the 
checkbox and radio button options for the repair order shipping line.

■ No Charge: The No Charge checkbox selection is defaulted based on Service 
Activities and Billing Types setup during implementation. If the checkbox has 
been selected while setting up the Service Activity and Billing Type related to 
the repair being processed, the No Charge checkbox will be selected by default. 
This implies that the customer is not being charged for that transaction. Do not 
attempt to select the No Charge checkbox while processing the transaction (if it 
is not already selected by default), because the system will not effect the No 

Note: Oracle recommends that you do not use the Receive/Ship 
tab for charging items. Rather, use the Repair Estimate tab to enter 
charges. 
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Charge flag on the transaction if the checkbox is selected at run-time. If you do 
not want to charge customers for a specific transaction, the checkbox must be 
selected in the Service Activities and Billing Types setup.

■ New Order: Select the New Order checkbox before interfacing a transaction to 
Order Management if you want to create a new order for the corresponding 
RMA or Ship Line. If you do not select this checkbox, all RMA, Ship, and 
estimate lines will be placed on the same order as long as the PO Number is the 
same.

Buttons
■ IB Txn Details: Click the IB Txn button to launch the Transaction Details 

window. Depot Managers can view the transaction details created by Charges 
for the customer product. They can view all attributes of the product as stored 
in Install Base. These attributes include Location, Configuration, Owner, 
Accounts, Contacts, Accounting Classification, Organization Assignments, and 
Extended Attributes. 

■ Receive: Click the Receive button to launch the Oracle Receiving window to 
receive the product and place it in a sub-inventory.

■ Ship: Click the Ship button to launch the Order Management Shipping 
Transactions window and ship the product to the customer.

■ Process: Submits the transaction lines to Order Management and returns a 
system generated number to the Order Num field.

Repair Estimate Tab
The Repair Estimate tab provides a summarized view of the repair estimate 
transactions needed to complete the repair. An estimate worksheet can be launched 
that allows entry of details or changes to charge lines entered in the Repair Estimate 
tab.

When a service request record exists, the Repair Estimate tab also provides access to 
the Knowledge Base. A repair order record is not necessary for you to access the 
Knowledge Base. While performing a teardown or inspection of a broken product, 
technicians can use the Knowledge Base to diagnose the damage and estimate the 
repair charges.
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The Repair Estimate tab presents the following functionality:

■ Status: Select a status from the dropdown list. Estimate statuses in Oracle Depot 
Repair include the following:

■ Accepted: An estimate approved by customer.

■ Bid: An estimate awaiting customer approval.

■ Cancelled: An estimate that has been cancelled.

■ Drafted: An estimate with information, but not ready to reveal to customer.

■ New: An estimate with no information entered.

■ Rejected: An estimate not approved by customer.

■ Date: Select a date from the Calendar to enter the creation date of the Repair 
Estimate.

■ Reason: Select a reason code from the LOV dropdown that best describes the 
reason for performing the repair estimate process.

■ PO Num: Enter the Customer or Vendor Purchase Order number to validate the 
acceptance of the repair estimate and/or customer's approval to proceed with 
the pending repair. This field value is not mandatory.

■ Summary: Enter a free text work summary or problem description that best 
describes the repair diagnosis or symptom of the broken product. 

■ Lead Time: Enter the number of units required to complete the product repair. 
This field is used in conjunction with UOM field to determine if units are in 
hours, days, weeks, etc.

■ UOM: Select a Unit of Measure to describe the lead time units required.

■ (Knowledge Base block) Service Code: A code provided by the service provider 
that serves as a repair classification. This field is read-only.

Note: A profile option set up during implementation allows your 
organization to specify whether to enable or disable the Repair 
Estimate tab in the Repair Orders window. The Repair Estimate tab 
will be disabled if the profile option is set to No. This implies that 
your organization does not want to use the Estimate functionality, 
and that you will use Tasks mode to process all repairs.
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■ (Knowledge Base block) Solutions: If solutions are linked to the repair order, 
this field displays the linked solutions.

The following fields are present in the Repair Estimate multi-record block:

■ Billing Category: Displays the billing transaction types of material, labor, or 
expense.

■ Product: Displays the selected item number from inventory.

■ Description: Displays the selected item description.

■ Serial Num: If the product selected in a material transaction is serialized, the 
Serial Number field is auto-populated when the product is selected.

■ Price List: Displays the selected Order Management price list.

■ UOM: Displays the unit of measure.

■ Qty: Displays the item number quantity for which service is being requested.

■ Unit Price: Displays the item's selling price from the selected price list.

■ Est Charge: Displays the charge after the contract entitlement has been applied.

The Summary of Estimated Charges block displays the following fields:

■ Material: Displays the subtotal of the estimated material required.

■ Labor: Displays the subtotal of the estimated labor required.

■ Expenses: Displays the subtotal of the estimated expenses required.

■ Total: Displays the combined subtotal of the material, labor, and expenses.

■ Currency: Displays the functional currency of the repair organization. Example: 
USD.

Buttons
■ (Knowledge Base block) Search: Launches the Knowledge Base Advanced 

Search form. Information passed as search criteria are Product and Work 
Summary.

Note: A repair order supports only a single currency. The system 
supports different currencies for different repair orders within a 
service request.
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■ (Knowledge Base block) Details: Select a solution linked to the repair order, and 
choose this button to launch the View Solution page. The View Solution page 
displays the selected solution details.

■ Estimate Notes: Used to enter justification notes that describe the estimated 
transaction line.

■ Line Details: Launches the detailed estimate worksheet.

■ Save Estimate: Records estimate header and charge line details.

■ Freeze Estimate: Freezes the repair estimate.

The Estimate Charge Line Details Worksheet
The Estimate Charge Line Details worksheet is used to edit details of charge lines 
entered in the Repair Estimate tab.

The worksheet uses Order Management Price Lists to determine the selling price for 
each item selected in transaction line, and obtains the item cost from the inventory 
item master list. The worksheet calculates the profit margin for each of the 
transaction lines as a percentage and actual dollar amount.

In the multi-record block, the Estimate Detail Worksheet displays the following 
charge line fields:

■ Billing Category

■ Product

■ Description

■ Serial Num 

■ Price List

■ UOM

■ Qty

Note: You can use the Estimate Charge Line Details worksheet 
only to edit details of charge lines created in the Repair Estimate 
tab. You cannot add new charge lines or delete existing charge lines 
using the Estimate Charge Details worksheet. To add a new charge 
line or delete an existing charge line, return to the Repair Estimate 
tab.
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■ Unit Price

■ Est Charge

The Estimate Line Details region presents more details of the charge line selected in 
the multi-record block:

Of all the fields displayed in the Estimate Line Details region, you can edit the 
following field values.

■ Billing Category

■ Product

■ Price List

■ UOM

■ Quantity

■ (Contract Information) Number

When you update these field values, the system automatically updates the 
remaining fields.

The Number field in the Contract Information block of the Estimate Line Details 
region displays the default repair order contract. This contract could be the best 
contract, the contract associated at the service request level, or the contract selected 
manually in the Product Coverage tab. See Details Tab for more information.

The default repair order contract populates the field for each estimate charge line. 
You can override this default value at the estimate line level by entering a different 
contract using the List of Values here. Also, if the default contract is cleared out for 
an estimate line, the service request contract at the service request level will still 
default for the estimate line when you click Save. However, you must click Apply 
Contract to discount the charges after saving the contract to the estimate line. 

Other fields include:

■ Revision: Displays the product revision number if the product is 
revision-controlled.

■ Serial Number: Displays the item serial number if the product is serialized.

■ Resource: Displays the resource type that was selected from the item master.

■ Unit Price: Unit price of the product.

■ Extended Price: Multiplies Quantity x Unit Price to display the extended price.

■ Item Cost: Displays the inventory cost for the selected item.
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■ Extended Cost: Multiplies Quantity x Item Cost to display the extended cost. 

■ (Contract Information) Description: Displays the Contract name for the selected 
contract number.

■ Discount: Displays the charges discounted by applying the selected contract.

■ Est Charge: Displays the charge for the relevant transaction after applying the 
contract.

■ Profit Margin: Displays the profit margin as a dollar value. For example, Profit 
Margin = $128.45.

■ Profit Margin%: Displays the profit margin as a percentage. For example, Profit 
Margin = 30%.

The Estimate Worksheet provides the following details in the lower section of the 
window:

Checkboxes
■ Override Charge: Select this checkbox before you click Save if you desire to edit 

the charges in a charge line later.

■ No Charge: When checked, discounts the charge line amount to zero or no 
charge.

Buttons
■ Save Estimate: Click this button to save the repair estimate charge lines.

■ Submit Charges: This button is enabled only for repair orders with WIP mode 
repair types. If the estimate charge lines entered have not been saved, clicking 
this button will create (save) the charge lines, as well as interface these charge 
lines to Order Management. If the charge lines have already been created 
(saved), clicking the Submit Charges button will interface these charge lines to 
Order Management.

■ Close: Click this button to close the Estimate Charge Lines Details window.

Repair Jobs Tab
The Repair Jobs tabbed page is deployed from the Depot Repair workbench, and 
displays details of WIP jobs pertinent to the repair order.

The Repair Jobs tab displays the following information:
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■ Job: The Repair Job Number is returned to this field after the repair job is 
submitted to the WIP module.

■ Group ID: This field is populated with the WIP Entity ID Number generated by 
the WIP module.

■ Organization: The organization field displays the name and number of the 
repair organization.

■ Qty (Submitted): This field displays the quantity of products submitted to the 
WIP repair job.

■ Qty Completed: This field represents the quantity of products that have 
completed the WIP repair job.

■ Status: The Status field displays the current status of a WIP repair job. The field 
displays the values Unreleased or Completed. The repair job shows status 
Unreleased after submission to the WIP repair job, and the status Completed 
after the WIP repair job is completed. 

■ (Routing) Primary: Primary Router refers to the original router that was used to 
manufacture the product and contains the original Bill of Materials.

Routers are created in BOM and used by WIP to facilitate the build or repair 
process. Each router contains the move steps and operations to be performed 
during the WIP, and records the labor and material in each step.

■ (Routing) Alternate: An alternate router refers to a modified router that is used 
to facilitate the repair or overhaul of a product in a WIP job.

Buttons
■ Complete Job: The Complete Job button launches the Oracle WIP Material 

Completion Transactions window allowing the service agent to complete the 
WIP repair job, and generate the WIP Summary Report.

■ Material Txn: Click the Material Txn button to launch the Oracle Inventory 
Material Issue window permitting the service agent to issue the broken 
products and material needed to stage the WIP repair job.

■ Repair Job: The Repair Job button launches the Repair Jobs workbench window 
with the repair order lines populated in corresponding fields.

■ View Job: Click the View Job button to launch the WIP Discrete Jobs window in 
a read only mode to view the status and additional details that are contained in 
the repair job.
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Repair Tasks Tab
The Repair Tasks tabbed page is deployed from the Depot Repair workbench, and is 
used to create the tasks needed to facilitate a product repair. This tab is enabled only 
if the repair type chosen has been defined, during implementation, to use the repair 
tasks functionality.

The tasks are listed in the Repair Tasks table. The following fields are displayed in 
the Repair Tasks tab multi-record block:

■ Number: Displays the system assigned task number.

■ Name: Displays the task or task template name.

■ Description: Displays the task template/task description.

■ Status: Displays the current task status.

■ Priority: Displays the task priority. Example: Critical, High, Medium, Low.

■ Actual Start: Displays the task start date.

■ Actual End: Displays the task end or completion date.

■ Owner: Displays the task owner's name.

The following fields are displayed on the Repair Tasks tab:

■ Number: Displays the system assigned task number.

■ Type: Displays the Depot task type. Example, Callback, Diagnostic, General, 
Repair, Upgrade.

■ Name: Displays the task name.

■ Status: Displays the current task status selected from the LOV.

■ Priority: Displays the task priority selected from LOV. Example: Critical, High, 
Medium, Low.

■ Description: A free text field to enter a detailed description of the displayed 
task. 

■ Owner Type: Displays the owner type selected from the LOV. Ex.: Employee, 
Group, or Team Resource.

■ Owner: Displays the task owner's name selected from the LOV.

■ Assignee Type: Displays the assignee type selected from Assignment Manager.

■ Assignee: Displays the assignee selected from Assignment Manager.
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The following date fields are displayed in the lower section of the Repair Tasks tab:

■ Planned Start: Displays planned start date.

■ Planned End: Displays planned end date. 

■ Scheduled Start: Displays scheduled start date. 

■ Scheduled End: Displays scheduled end date. 

■ Actual Start: Displays actual start date. 

■ Actual End: Displays actual end date. 

The following additional fields are displayed in the lower section of the Repair 
Tasks tab:

■ Estimate Effort: Displays estimated number of units to complete the task.

■ Estimate UOM: Displays unit of measure used to describe the estimated effort.

■ Actual Effort: Displays actual number of units used to complete the task.

■ Actual UOM: Displays unit of measure used to describe the actual effort.

Buttons
■ Assignment Manager Icon: Launches the Assignment Manager window.

■ Use Template: Launches the Create Task from Template window to permit 
creation of new tasks from predefined templates.

■ Launch Workflow: Starts the task workflow to reserve the designated resources 
and notify the task owner of task creation.

■ Debrief: Launches the Debrief Report window to capture the material, labor, 
and expense billing transactions used to complete the task.

■ Submit Charges: Click this button to interface the task charge lines entered in 
the Debrief Report to Order Management.

■ More: Launches the screens to display and capture additional task details 
including:

■ Resources: Defines and displays resource requirements, assignments and 
scheduling information.

■ Dependencies: For ordering and prioritization of multiple tasks.

■ Reference: Permits linking of task to different documents or to other 
pertinent background information.
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■ Dates: Used to identify more dates in addition to the planned dates.

■ Contacts: Enables creation and management of multiple contacts assigned 
to a task. Contact information is obtained from customer information.

■ Recurrences: Enables the scheduling of tasks to occur automatically.

■ Others: Identifies additional information about the task.

■ Audit: Displays an audit history log with the changed dates, and the user 
responsibility that initiated the changes.

Activity Tab
The Activity tab provides the depot agent with the most recent status of the 
customer's repair order. The agent can view the latest status with each event date 
and time stamped at the completion of a process step.

The following fields are displayed in the top section of the Activity window:

■ Qty Received: RMA quantity received back by the depot.

■ Qty Submitted to WIP: Repair Order quantity submitted to the repair job.

■ Qty Completed in WIP: Repair job quantity completed in WIP. 

■ Qty Shipped: Repair Order quantity shipped against the Sales Order.

The following fields are displayed in the lower multi-record block:

■ Event: The Repair Order event completed by the depot.

■ Date: The date/time stamp when activity was completed.

■ Qty: Quantity processed at the completion of the event.

■ Details: Reference document name, number, owner.

Service History Tab
The Service History tabbed page displays all the service requests and depot repair 
orders that have been logged against an Install Base product. 

Note: Qty Submitted to WIP and Qty Completed in WIP fields 
appear only for repairs being processed in WIP mode.
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A service agent can view a document by clicking on the hyper linked Repair Order 
or Service Request Number to launch and display the historical document. This 
functionality permits the service provider to review the service history and repair 
records spread over the lifetime of the Install Base product.

The Service History Tab displays the following information in the multi-record 
blocks:

Service Requests
■ Number: Service Request number.

■ Date Opened: Displays date the service request document was created.

■ Date Closed: Displays date the service request document was closed.

■ Type: Displays the service request type.

■ Status: Displays the current service request status.

■ Severity: Displays the severity set by the owner of the service request/ repair 
order.

■ Urgency: Displays the customer's urgency being weighted on the service 
request. 

Repair Orders
■ Number: Repair Order number.

■ Date Opened: Displays the date on which the repair order document was 
created.

■ Date Closed: Displays the date on which the repair order document was closed.

■ Type: Displays the service request type. 

■ Status: Displays the current repair order status.

■ Service Request: Displays the service request number linked to the repair order.

Note: A product must be serialized and linked to an Install Base 
reference number in order for this functionality to work.
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Product Coverage Tab
The Product Coverage tab displays detailed information about the Install Base 
product and Contract entitlements. When you select the Product Coverage tab in 
the Repair Orders window, active entitlements or all entitlements (based on radio 
button selection) applicable to the selected repair order are displayed.

The following fields are displayed in the multi-record block region:

■ Contract Num: The product warranty or service contract number.

■ Service: The contract name; Warranty, PM, Support Only, Full Service.

■ Description: High-level description of the contract offering. 

■ Coverage: The service provider's contract coverage window in days and hours.

■ Start Date: The warranty or contract's effective start date.

■ End Date: The warranty or contract's effective end date.

The Product Coverage tab also provides access to the following:

Radio Buttons
■ View Active Contracts: Selecting this radio button displays the active 

entitlements that are applicable to the selected repair order.

■ View All Contracts: Selecting this radio button displays all the entitlements 
applicable to the selected repair order, including those that have already 
expired.   This is a handy tool for service agents to inform customers about 
contract coverage expiry and service contract renewal opportunities to reinstate 
product coverage.

Buttons
■ View Coverage: This button launches the Service Contracts Coverage window 

showing details of the selected coverage. You can access this window also by 
double-clicking the Coverage (field) value of an entitlement. For more 
information, please refer to the online help available from the Service Contracts 
Coverage window.

■ Apply: Select the contract entitlement that you want to use as default using the 
Default checkbox, and click Apply. This will override the existing default 
contract. This selected contract now becomes the default contract for the repair 
order. However, note that this contract cannot be applied to the Task Debrief 
charge lines. Instead, the contract selected at the service request level will apply 
by default to the Debrief charge lines. 
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Checkboxes
■ Default: This checkbox permits the service agent to select a contract coverage to 

override the coverage selected at the service request level. Select the Default 
checkbox corresponding to the relevant contract coverage, and click Apply to 
effect this change. The system defaults this coverage to all charge lines 
associated with the selected repair order. This selected default contract, 
however, cannot be applied to the Task Debrief charge lines. The contract 
selected at the service request level will be applied by default to these charge 
lines. 

Repair Orders Window Tools Menu 
The Tools Menu provides several programs to complete the logistics and repair 
processes for the repair order.

■ Update Receiving: When receiving is completed, this program updates the 
Depot receiving status.

■ Update Repair Job: When the repair job is completed, this program updates the 
Depot WIP job or task status.

■ Update Shipping: When shipping is completed, this program updates the Depot 
shipping status.

■ Profile: To view an existing customer profile, select Profile from the Tools menu. 
Please refer to Oracle Support User Guide and Oracle Support Implementation Guide 
for proper setup of the Profile window with customizable options.

■ Send Message: Select Send Message from the Tools menu to send a workflow 
notification message, and have that message link to the Repair Order selected in 
the Depot Repair Workbench at the time the message was sent. For more 
information, see Oracle Support User Guide.

■ View Message History: Select View Message History from the Tools menu to 
launch the Message History window. For more information, see Oracle Support 
User Guide.

Repair Jobs Search Window
The Repair Jobs Search window permits you to search for repair jobs issued for 
products that have already been received into the repair organization. The Repair 
Jobs Search window is accessed by double-clicking Submit Repair Jobs under Depot 
Repair in the Navigator window. Double-clicking Submit Repair Jobs launches the 
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Organizations window where you choose the organization where the relevant item 
will be repaired.

In the Repair Jobs Search window, the Repair Organization field has its value 
defaulted from the value you selected in the Organizations window.

Use the following fields in the Repair Jobs Search window to specify your search 
criteria:

Repair Order Block
■ Repair Order: The Repair Order Number corresponding to the Repair Job.

■ Product Code: The product part (item) number as defined in Item Master.

■ Product Description: The description of the product.

■ Promise Date: Date in which product is promised after repair. You can enter a 
promise date range if you desire to perform a search based on this attribute. 

■ Creation Date: Date in which repair order was created. You can enter a creation 
date range if you desire to perform a search based on this attribute.

Service Request Block
■ Caller Type: As applicable, select Organization or Person from the dropdown 

list. The default is organization. 

■ Customer Name: The name of the person or organization.

■ Severity: The service request severity value defaulted from the corresponding 
service request.

■ Service Request: The Service Request Number corresponding to the repair job.

■ Customer Number: Same as Customer Account Number.

■ Urgency: The urgency with which to attend to the service request, with value 
defaulted from the corresponding service request.

Buttons
■ Clear: Click Clear to clear the fields in which you have entered values to specify 

your search criteria. You can enter new values in these fields to perform a new 
search.

■ Search: Click Search to start the query after entering your search criteria. To 
select a row from among the Search Results, hold down the Control key and 
click the row. 
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Results Block
The search results appear displaying the following field values:

■ Item: The product part number.

■ Item Description: Product description.

■ Customer Name: The customer name.

■ Customer Number: The customer account number.

■ Repair Number: The repair order number.

■ Repair Type: The repair type specified while creating the repair order. See 
Details Tab for more information. 

■ Promise Date: The date on which product has been promised after repair.

■ Service Request Urgency: Urgency specified in the service request.

■ Service Request Severity: Severity specified in the service request.

■ Approval Status: estimate approval status. See Revising a Repair Order and 
Obtaining Customer Approval for more information.

■ Repair Status: repair order status. See Revising a Repair Order and Obtaining 
Customer Approval for more information.

■ Service Request Number: The corresponding service request number.

■ Service Request Type: The service request type. See Service Request Information 
Block for more information.

■ OK (Button): Click OK to proceed to submitting repair orders selected from 
among the search results to WIP. This will launch the Submit Repair Jobs 
window.

■ Cancel (Button): Click Cancel to abort the search or any further proceeding 
using the search results. This closes the Repair Jobs Search window.

Submit Repair Jobs Window
Use the Submit Repair Jobs window to submit a single WIP repair job for single or 
multiple repair orders to WIP. 

The Submit Repair Jobs window includes the following fields:
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Repair Jobs Parameters Block
The Product, Revision (Product Revision Number defaulted from service request if 
the product is revision-controlled), and Repair Org fields are automatically 
populated when you launch the Submit Repair Jobs window. The other fields in the 
Repair Jobs Parameters block include:

■ Job Type: Select the value Non-Standard without Router in this field. If you 
select the value Non-Standard with Router, a primary route specification is 
mandatory. 

■ Repair Job: The job name that will be used when submitting the job.

■ Job Status: The job status with which a job is submitted to WIP. Possible values 
are Released and Unreleased. Note that for a job to begin, or for materials to be 
issued against the job, the Job Status must be Released.

■ Accounting Class: The account against which the valuation or the variance for 
the repair job will be charged.

■ Primary: Refers to the primary route that the WIP job will follow. The repair job 
will be submitted with the value specified in this field as the primary route to 
apply.

■ Alternate: Represents an alternate route that the job can follow. The repair job is 
submitted to WIP with the value specified in this field as the alternate route.

■ Start: Represents the WIP job start date.

■ Complete: Represents the date within which the WIP job is to be completed.

For more information on WIP related fields such as, Job Type, Accounting Class, 
Primary, and Alternate, please refer to Oracle WIP User’s Guide.

Repair Order Information Block
The repair order line/lines you selected from among the search results in the Repair 
Jobs Search window populate the Repair Order Information block.

■ Ordered: Represents the item quantity in a repair order.

■ Received: Represents the quantity of items received against a repair order.

■ Submit: Quantity of items in a repair order submitted to WIP for repair.

■ Total Quantity Submitted to Release: Represents the total quantity of items 
submitted to WIP in the Released status. This is the same as the Released 
quantity for a repair order line when only one repair order is selected for 
Overview of Using Oracle Depot Repair 2-27



Submit Repair Jobs Window
submission to WIP. When you are creating a repair job for multiple repair 
orders, this field value is the sum of the quantities released per repair order. 

Search Criteria Region
The Search Criteria region at the bottom left corner of the screen lists the different 
attributes of the result returned when you performed the search using the Repair 
Jobs Search window.

Buttons
■ New Search: Click the New Search button to launch the Repair Jobs Search 

window, and perform a new search. The Submit Repair Jobs window is closed 
when you click New Search.

■ Close: Click Close to close the Submit Repair Jobs window and return to the 
Navigator window.

■ Submit Job: Click Submit Job to submit the repair order line/lines to WIP.
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Depot Repair Business Scenarios

Business process flows vary with business scenarios. This chapter presents 
information on working with different depot repair business scenarios.

For detailed procedures on handling the different processes comprising the business 
flow scenarios discussed here, refer to Managing Depot Repair Processes.

Topics discussed in this chapter include:

■ Processing a Repair and Return

■ Processing a Loaner, Repair and Return 

■ Processing an Exchange

■ Processing an Advanced Exchange

■ Processing a Replacement

Processing a Repair and Return
Perform the following steps in the recommended order to process a repair and 
return scenario. See Repair and Return for more information.

To process a repair and return: 
1. Create a Service Request in the Depot Repair workbench.

2. Create a Repair Order with Repair Type Repair and Return.

3. System auto-creates two transaction lines with action type RMA and SHIP.

4. Process the RMA Order transaction line by confirming the following in the 
Receive/Ship tab of the Repair Orders window:

a. Process transaction checkbox is selected
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b. Automate order processing steps through checkbox is selected

c. Enter Order radio button is selected

d. Book Order radio button is selected 

5. Receive the damaged product using the Receive Button located on the Receive/ 
Ship Tab of the Repair Orders window. Run the Update Receiving program 
from Tools menu after the broken product has been successfully placed into 
inventory.

6. Inspect and diagnose the broken product. Use the Knowledge Base to search for 
possible causes and solutions for the problem.

7. Estimate the repair charges and obtain the customer’s approval.

■ If the customer accepts the repair estimate, then proceed to step 8.

■ If the customer rejects the repair estimate, then close the Repair Order and 
the service request to end this scenario.

8. Update the Repair Order customer approval status to accepted.

9. Manage the repair process using either WIP or Tasks repair mode. The repair 
mode is determined by the definition of the repair type during setup. Based on 
this definition, the Repair Jobs tab or Repair Tasks tab will be enabled.

To manage the repair process using WIP:

a. Use the Repair Job button on the Repair Jobs tab to create a WIP repair job 
for the repair order.

b. Close the Repair Jobs window to return to the Repair Jobs Tab.

c. Click the Material Txn button to launch the Material Transaction window.

d. Enter the required material needed to complete the Repair Job.

e. Process the repair job in WIP. Click the Complete Job button to complete the 
repair job.

f. After the WIP job is completed, run the Repair Job Update program from 
the Tools menu.

g. Enter final repair charges in the Repair Estimate tab, and click Submit 
Charges.

To manage the repair process using Tasks:

a. Using the Repair Tasks tab, create tasks to complete the repair. Use 
predefined task templates if desired.
3-2 Oracle Depot Repair User Guide



Processing a Loaner, Repair and Return
b. Assign resources to the tasks.

c. Debrief tasks using Debrief Report.

d. Update task statuses.

10. On the Receive/Ship tab, confirm that the following checkboxes/radio buttons 
are selected:

a. Process transaction

b. Automate order processing steps through

c. Enter Order

d. Book Order

e. Pick Release

f. Ship Confirm

11. Click the Save Icon to submit the repair Sales Order transaction charge line to 
Order Management.

12. After the product is shipped, run the Update Shipping program from the Tools 
menu. 

13. Invoice the customer for the repair.

14. Close the repair order.

15. Close the service request.

Processing a Loaner, Repair and Return
Perform the following steps in the recommended order to process a repair and 
return with loaner scenario. See Loaner, Repair and Return for more information.

To process a loaner, repair and return: 
1. Create a Service Request in the Depot Repair workbench.

2. Create Repair Order with Repair Type Repair and Return with Loaner.

3. System auto-creates four (4) transaction charge lines:

■ Sales Order line for loaner

■ RMA line for broken product return

■ Sales Order line for repair of broken product
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■ RMA line to track the loaner product return

4. In the Receive/Ship tab, process the RMA and loaner sales order by confirming 
that the following checkboxes/radio buttons are selected: 

■ Process Transaction (for loaner sales order and broken product RMA)

■ Automate order processing steps through

■ Enter Order

■ Book Order

■ Pick Release

■ Ship Confirm

5. Receive the broken product.

6. After the RMA receipt has completed successfully, run Update Receiving 
program from the Tools menu.

7. Inspect and diagnose the product damage. Use the Knowledge Base to search 
for possible solutions.

8. Estimate the repair charges, and obtain customer approval.

■ If the customer accepts the repair estimate, proceed to step 10.

■ If the customer rejects the revised estimate, then:

* Close the repair order.

* Close the service request.

* End this scenario.

9. Update the repair order customer approval status to Approved.

10. Manage the repair process using WIP or Tasks repair mode. For details, see Step 
9 of Processing a Repair and Return.

11. In the Receive/Ship tab, process the ship order transaction by confirming that 
the following checkboxes/radio buttons are selected:

■ Process transaction (sales order for repaired product)

■ Automate order processing steps through

■ Enter Order

■ Book Order
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■ Pick Release

■ Ship Confirm

12. Click the Save icon on the toolbar to submit the repair Sales Order transaction 
charge line to Order Management.

13. After the product has been shipped, run the Update Shipping program from the 
Tools menu. 

14. Invoice the customer for the repair.

15. Receive the RMA loaner product. In the Receive/Ship tab, process the loaner 
RMA by confirming that the following checkboxes/radio buttons are selected:

■ Process Transaction (for loaner RMA)

■ Automate order processing steps through

■ Enter Order

■ Book Order

16. Issue an RMA Credit to the customer for returning the loaner product.

17. Invoice the customer for the loaner product rental charges if required.

18. Close the repair order.

19. Close the service request.

Processing an Exchange
Perform the following steps to process an exchange, in which a product is sent to 
the customer once the broken product has been received by the depot. See Exchange 
for more information.

To process an exchange:
1. Create a Service Request in the Depot Repair workbench.

2. Create a Repair Order with Repair Type Exchange. The system auto-creates two 
transaction lines with action type RMA and SHIP.

3. Using the Receive/Ship tab of the Repair Orders window, process the RMA 
Order transaction line by confirming that the following checkboxes/radio 
buttons are selected:

■ Process transaction
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■ Automate order processing steps through

■ Enter Order

■ Book Order 

4. Receive the customer's damaged exchange product.

5. After the RMA receipt is completed successfully, run the Update Receiving 
program from the Tools menu.

6. Using the Receive/Ship tab, process the Ship transaction line by confirming that 
the following checkboxes/radio buttons are selected:

■ Process transaction (sales order for shipping)

■ Automate order processing steps through

■ Enter Order

■ Book Order

■ Pick Release

■ Ship Confirm

7. Click the Save icon to submit the Sales Order Ship charge line to Order 
Management.

8. After the exchange product has shipped successfully, run the Update Shipping 
program from the Tools menu.

9. Invoice the customer for the product exchange.

10. Close the repair order.

11. Close the service request.

Processing an Advanced Exchange
Perform the following steps to process an advanced exchange, in which an 
exchange product is sent to a customer before the damaged product has been 
received back from the customer for a core credit. See Advanced Exchange for more 
information.

To process an advanced exchange:
1. Create a Service Request in the Depot Repair workbench.
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2. Create Repair Order with Repair Type Advanced Exchange. The system 
auto-creates two transaction lines with action type SHIP and RMA.

3. Using the Receive/Ship tab of the Repair Orders window, process the Sales 
Order transaction by confirming that the following checkboxes/radio buttons 
are selected:

■ Process Transaction

■ Automate order processing steps through

■ Enter Order

■ Book Order

■ Pick Release

■ Ship Confirm

4. After the Sales Order shipment has completed successfully, run the Update 
Shipping program from the Tools menu.

5. Invoice the customer for the Advanced Exchange product.

6. Using the Receive/Ship tab, process the RMA Order transaction line by 
confirming that the following checkboxes/radio buttons are selected:

■ Process Transaction (RMA order line)

■ Automate order processing steps through

■ Enter Order

■ Book Order

7. Click the Save icon to submit the RMA charge line to OM.

8. Receive the customer's broken RMA Exchange product.

9. Run the Update Receiving program from the Tools menu.

10. Issue an RMA Credit to the customer for the core return.

11. Close the repair order.

12. Close the service request.

Processing a Replacement
Perform the following steps to process a replacement, in which the depot sends a 
replacement product to the customer. See Replacement for more information.
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To process a replacement:
1. Create a Service Request in the Depot Repair workbench.

2. Create a Repair Order with Repair Type Replacement.

3. System auto-creates one transaction line with action type SHIP.

4. Use the Receive/Ship tab of the Repair Orders window to process Sales Order 
transaction by confirming that the following checkboxes/radio buttons are 
selected:

■ Process Transaction

■ Automate order processing steps through

■ Enter Order

■ Book Order

■ Pick Release

■ Ship Confirm

5. Click the Save icon to submit the Sales Order charge line to Order Management.

6. After the replacement product is shipped successfully, from the Tools menu, run 
the Update Shipping program.

7. Invoice the customer for the replacement product.

8. Close the repair order.

9. Close the service request.
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Managing Depot Business Processes

Oracle Depot Repair is designed to improve the efficiency of the depot repair 
process.

Many different users may be involved in the overall depot process. These users and 
roles include the Call Center Agent, Service Technician, Shop Floor Technician, 
Shop Floor Accountant, Shop Floor Production Manager, Warehouse Administrator, 
Shipping Administrator, Receiving Administrator, Service Administrator, Accounts 
Receivable Manager, Purchasing Manager, HR Manager, and Depot Manager.

For example, the Call Center Agent logs the service request, the Service Technician 
diagnoses the broken part, the Shop Floor Technician fixes the product, the Shop 
Floor Accountant keeps track of the repair costs, the Shop Floor Production 
Manager schedules the repair jobs, and the Depot Manager has the overall repair 
process responsibility. Depending on the service organization, a user may have 
multiple roles. For example, the Service Technician may log the service request, and 
diagnose the broken part.

This chapter presents task-based procedures for different processes that a user may 
need to perform to fulfil responsibilities.

Topics discussed in this chapter include:

■ Viewing Customer Profile

■ Viewing Product Coverage Information

■ Viewing Product Service History

■ Creating a Customer Contact

■ Creating a Service Request

■ Creating a Repair Order

■ Finding Service Requests and Repair Orders
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■ Creating and Maintaining Notes

■ Using the Knowledge Base

■ Estimating Repair Charges

■ Revising Repair Estimates

■ Revising a Repair Order and Obtaining Customer Approval

■ Creating an RMA Manually

■ Including RMA and Ship LInes on the Same Order

■ Receiving a Broken Product

■ Shipping Additional Items

■ Managing the Repair Process

■ Creating a WIP Repair Job for a Single Repair Order

■ Processing a WIP Repair Job for a Single Repair Order

■ Creating a WIP Repair Job for Multiple Repair Orders

■ Processing a WIP Repair Job for Multiple Repair Orders

■ Creating Multiple WIP Repair Jobs for a Single Repair Order

■ Creating Repair Tasks

■ Entering and Updating Task Details

■ Preparing the Repair Tasks Debrief

■ Viewing Activities Related to a Repair Order

■ Updating Repair Orders Concurrently

■ Workflow-Based Messaging

■ Entering Final Charges and Creating the Shipment

■ Shipping an Item

■ Invoicing a Customer

■ Closing a Repair Order

■ Closing a Service Request
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Viewing Customer Profile
The customer Profile summarizes customer information. The profile entries 
appearing in the customer profile are typically set up by a system administrator, 
and contain a set of predefined checks. These checks are configurative, as are the 
actual range values and value definitions. The check results are displayed by 
utilizing the Customer Profile Engine, which is a concurrent program.

The customer profile information is displayed in the Profile window when you 
select Profile from the Tools menu in the Repair Orders window. Click Refresh in 
the Profile region to view the latest profile information for the customer. This Oracle 
Depot Repair functionality allows service agents to check a customer’s profile 
information, such as Open Orders, Booked Orders, Cancelled Orders, Open Service 
Requests, Escalated Service Requests, Active Contracts, Expired Contracts, 
Cancelled Contracts, Open Repair Orders etc.

Prerequisites:
Repair order records associated with the customer must exist in the database.

To view the customer profile and drill down to the details:
1. From the Depot Repair Navigator, navigate to the Repair Orders window using 

the following path:

Depot Repair > Repair Orders > (Repair Orders Search window) New

2. In the Repair Orders window, select the customer whose profile you want to 
check.

3. Select Profile from the Tools menu. The Profile window opens.

4. Double-click on a key indicator in the profile window. Oracle Depot Repair 
presents a summary list of that profile check. For example, double-clicking on 
Open Service Request (a key indicator) displays the drill down list showing all 
open service requests for the selected customer type.

This list displays information such as the service request number, incident date, 
problem code and resolution code.
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5. Double-click on any line in the summary list. Oracle Depot Repair displays the 
appropriate window containing details of the selected line.

Viewing Product Coverage Information
Products that are covered by a Warranty or Service Contract, and linked to the 
Install Base record, will populate the product coverage fields with a list of all 
entitlements or all active entitlements (based on radio button selection) that are 
applicable to the selected repair order. See Details Tab for more information. The 
service agent can double-click a Coverage field value to view details of that 
coverage.

Oracle Depot Repair permits the service agent to select a contract coverage that can 
be applied to the Sales Order charge lines created by Charges. The selected Contract 
Number will be automatically defaulted on each charge line that is generated from 
the WIP Summary Report only. This option will exclude those charge lines, which 
relate to any new product upgrades and enhancements. The agent can check for 
active product warranties existing for the product. Also, the contract selected as 
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default in the Product Coverage tab cannot be applied to charge lines in the Tasks 
Debrief. Instead, the contract selected at the service request level will be applied by 
default to the Debrief charge lines. 

Oracle Depot Repair also permits the agent to find all contracts including those that 
have already expired. This is a handy tool for service agents to advise customers on 
contract coverage expiry, and service contract renewal offers to reinstate their 
coverage.

Prerequisites:
You can view product coverage information only for an install base product 
referenced on a repair order.

To view product coverage information:
1. Retrieve the repair order referencing the product for which you want to view 

product coverage information (see Finding Service Requests and Repair 
Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Product Coverage tab in the Repair Orders window.
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The tab displays the configuration and entitlements for the install base product 
referenced on the repair order.

Based on radio button selection, you can automatically query all contracts or all 
active contracts applicable to the repair order using the Product Coverage tab. 
By selecting the Default checkbox beside a contract, you will apply this as the 
default contract to the repair order. For detailed field descriptions, see Product 
Coverage Tab.

If you select a contract that does not specify a price list, the system will default 
the price list that is set for the default price list profile option. This will happen 
if the price list currency is the same as the repair order currency. If the price list 
currency is not the same as that of the repair order, or if the profile option is not 
set, you can select any price list from the List of Values.

Viewing Product Service History
Service agents can view all the service requests and depot repair orders that were 
logged against a service product. The product must be serialized and linked to an 
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Install Base reference number in order for this functionality to work. This valuable 
functionality permits the service provider to review the service history and repair 
records that were recorded over the lifetime of the install base product, and is 
especially useful when attempting to troubleshoot and diagnose repair patterns and 
service trends that affect the product.

Use the following procedure to view a product’s service history. 

Prerequisites:
You can view the service history of only an install base product. Repair order 
records must exist for the product.

To view product service history:
1. Retrieve the repair order corresponding to the product, the service history of 

which you want to view (see Finding Service Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Service History tab of the Repair Orders window. The tab lists all the 
service requests and depot repair orders previously opened against the install 
base product on a repair order. For detailed field descriptions, see Service 
History Tab.
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Creating a Customer Contact
You can create a new Contact for a customer in the Repair Order window, and use 
this contact while creating your new service request.

Prerequisites:
The customer whose new contact is being created must have an existing record in 
the database.

To create a new contact:
1. From the Depot Repair Navigator, use the following path to navigate to the 

Repair Orders Search window:

Depot Repair > Repair Orders

The Repair Orders Search window allows you to search for existing service 
requests and repair orders.
4-8 Oracle Depot Repair User Guide



Creating a Customer Contact
2. In the Repair Orders Search window, click New to launch the Repair Order 
window.

The Repair Orders window serves as the Depot Repair workbench allowing 
depot agents to perform all depot processes, end-to-end, from a single 
workbench.

3. In the Repair Orders window, in the Service Request Information block, click 
New Contact. The New Customer window opens.

4. In the New Customer window, select the Customer Type; Person or 
Organization. Customer Type refers to the type of the contact, and indicates 
whether the contact is a person or an organization.

If you select the Customer Type Person, the following fields appear:

■ Title indicates the contact’s title, such as Miss, Mr. , Mrs., and Dr. 

■ First, Last, Middle, Suffix indicates the First, Last and Middle names of the 
contact, and Suffixes in the name if any.

■ Phone indicates the contact’s phone number. You can look up area codes in 
the List of Values (LOV).
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■ Type refers to the phone type, such as Work, Home, Cell, or General. Select 
this value from the dropdown list.

■ Relation specifies the contact’s relationship with the customer, such as 
Associate of, Child of, and Benefactor of. Select this value from the LOV.

■ Party refers to the name of the customer. You can enter this value using the 
LOV.

■ Email; enter the contact’s e-mail address here.

■ Create Account checkbox, when selected, will create an account for the new 
contact in your database.

■ Bill to refers to the address to which the contact’s bill is to be sent.

When you have entered the Country in the Address field, the Address 
window appears where you can select the Context Value to choose the 
contact’s Address style, such as North European, Japanese, or South 
American. After you select the Context Value, the Address window 
provides you with fields appropriate to the address style you have chosen. 
Enter the address, and click OK.

■ Ship to refers to the address to which you should ship a product for the 
contact.

■ Primary checkboxes indicate whether the Bill to and Ship to addresses are 
the contact’s primary addresses.

If you select the Customer Type Organization, the Title, First, Last, Middle, 
and Suffix fields are replaced with the Organization name field. All the 
other fields remain the same with the exception of an additional field for 
the organization’s URL or web address.

5. Click OK in the New Customer window. A note appears informing you that a 
Party Number and an Account Number (if you selected the Create Account 
checkbox) has been created and saved for the new contact.

6. Click OK on the note. The application returns you to the Repair Orders window.

Creating a Service Request
Service requests initiate the actions required to solve a customer problem. A service 
request is mandatory for any repair process, and needs to be created before any 
repair order can be created in the Oracle Depot Repair module.
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The depot agent can use the Repair Orders window to log a customer request for 
assistance. The application allows you to create service requests without having to 
leave the Depot Repair workbench.

Oracle Depot Repair also allows the depot agent to add products to a customer’s 
install base directly from the Depot Repair Workbench. This enables the depot to 
process Install Base trackable repair items that the customer purchased from outside 
the service organization. When you try to save a service request record for such an 
item without entering the Install Base Reference Number, the system returns a 
prompt. Click Add to IB on this prompt to add the item to the Install Base. You can 
then proceed with processing the repair item not sold by the organization.

Prerequisites:
The customer and contact records must exist in the database. Service requests can 
be logged only for products recorded in inventory.

To create a service request:
1. From the Depot Repair Navigator, use the following path to open the Repair 

Orders Search window:

Depot Repair > Repair Orders

You can search for existing service requests and repair orders using the Repair 
Orders Search window. See Finding Service Requests and Repair Orders.

2. In the Repair Orders Search window, click New. This launches the Repair 
Orders window. 

3. In the Service Request Information block in the Repair Orders window, the 
Contact Type, Customer Type, Severity, Status, and Opened date fields default 
to Relation, Organization, High, Open, and the current date respectively.

■ Choose the Contact Type and Customer Type from the dropdown list, and 
use the List of Values to select the Contact, Customer, Request Type (such as 

Note: You cannot create a service request without a value in the 
Product field if the profile CSD: Require Product For Service 
Request has been set to Yes during implementation. Setting this 
profile option to No allows you to create a service request without 
entering a value in the Product field. Also, when the profile option 
is set to No, you can specify an install base product without 
specifying an Install Base Reference Number in the service request. 
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Customer Call, Depot Repair, Field Service), Severity, and Status fields. 
Note that you can also enter the time in the Opened field.

Note that Contact information is not mandatory for creating a service 
request. Not entering any value in the Contact Type field will disable all 
Contact information fields.

Also, you can create service requests for internally owned product repairs if 
the system has been set up to allow internal repairs. In this case, the 
customer is the internal party, and you will need to leave the 
Product-related fields empty.

■ The Bill To and Ship To address fields are populated automatically when 
the Customer and Contact Names are entered. The addresses will always 
default to the primary bill-to and ship-to addresses of the customer. Even if 
you select a primary address for the Install Base instance, the Bill-To and 
Ship-To address fields will only default to the primary address of the 
customer party. Also, the List of Values for these fields will only contain 
customer party addresses. Contact addresses will not be listed even if a 
Contact is selected.

For more information, see The Service Request Information Block.

4. Enter the Product with which the customer is reporting damage using the List 
of Values.

Note that if you choose to first enter the Serial Number value for a serialized 
product, the Product field will be automatically populated when you select the 
Serial Number value. Also, if you choose to first enter the Install Base Reference 
Number for the product being serviced, the Product field will be automatically 
populated when you select the Reference Number value from the List of Values.

5. To validate the product against the Install Base, select the Installed Base 
checkbox.

If the product is serialized, the Serial Number should be provided. After 
validation, the Install Base Reference Number (Instance Number) is 
auto-populated. For a given customer, the call center agent can view all the 
products in the customer Install Base.

6. Enter the name of the person responsible for overseeing the service request in 
the SR Owner field using the List of Values.

7. Enter a brief summary of the repair issue in the Summary text field.
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8. Click the Save icon on the toolbar to create the service request record. The 
application populates the Request field in the Service Request Information 
block with the Service Request Number. When you click on any of the fields in 
the Repair Order Information block, the system populates the Product, Product 
Description, UOM, and Quantity fields.

Creating a Repair Order
The depot business process starts with a repair order. Repair orders are created only 
against service requests for serviceable products. If the product exists in the 
customer's Install Base, it should be validated. For items under serial control or 
revision control, correct serial number or revision must be provided.

You can create repair orders against items that have already been returned to 
in-house inventory, by appropriately setting a profile option (during 
implementation) that allows you, while creating a repair order, to view and select 
products that are in in-house inventory. The Serial Number and Install Base 
Reference Number List of Values will then display product instances within the 
service organization. If you need to create a repair order against an internally 
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owned product instance, you will need to leave the Product-related fields empty in 
the Service Request Information block of the Depot Repair workbench.

The depot agent can view activities performed against a service request that was 
initiated in the call center and transferred to the depot for resolution. You can link 
RMAs and sales orders generated through the call center to repair orders created 
within the Depot Repair Workbench. Query the call center service request using the 
Repair Orders Search window (see Finding Service Requests and Repair Orders), 
and click OK on the prompt to proceed to creating a repair order against the service 
request.

Oracle Depot Repair also allows the depot agent to add products to a customer’s 
install base from the Depot Repair Workbench. This enables the depot to process 
(Install Base trackable) repair items that the customer purchased from outside the 
service organization. If you try to create a repair order line without specifying a 
product or Install Base Reference Number, the system returns a prompt. Click Add 
to IB on the prompt to add the product to the Install Base. This will allow you to 
process the repair.

Use the following procedure to create a repair order using the Depot Repair 
workbench.

Prerequisites:
A service request record must exist for the damaged product in order to create a 
repair order for its repair.

To create a repair order:

1. Using the Repair Orders Search window, retrieve the pertinent service request 
(see Finding Service Requests and Repair Orders).

2. Select the relevant service request, and click OK. This launches the Repair 
Orders window, populated with the service request information.

3. In the Repair Order Information block in the Repair Orders window, confirm 
the information presented in the table, or enter the appropriate information for 
the damaged product.

Note: You can also proceed to creating a repair order immediately 
after creating a service request record, without having to navigate 
to the Repair Orders Search window.
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4. In the Details tab, select the Repair Type from the List of Values. For more 
information on Repair Types, see Repair Type Processing. For field descriptions, 
see Details Tab.

Note: A repair order supports a single currency. Different currencies are 
supported for different repair orders within a service request. The default 
currency is based on the default contract. If no default contract is selected, the 
default price list determines the currency. If neither defaults are set, the 
currency selection is based on the manually selected Price List in the Details tab.

After a charge line is created, you cannot change the currency of the repair 
order in the Details tab or select another default contract that has a price list 
with a different currency. To change the currency of a repair order, all the charge 
lines have to be deleted.

5. Enter the Promise Date (date and time) for repair completion after negotiation 
with the customer.

6. Enter the name of the person responsible for overseeing the repair in the Repair 
Owner field using the list of values.

7. Click Save to create the Repair Order. The system populates the Repair Number 
fields both in the Details tabbed page, and in the Repair Order Information 
block, with the Repair Order Number.

8. After having created the repair order record, you can attach additional 
information to the service request or repair order using the Notes button in the 
Details tabbed page. For detailed information, see Creating and Maintaining 
Notes.
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9. After creating the repair order record, you can also use the Search button in the 
Repair Estimate tab to search for possible solutions to the repair issue. The 
service agent can use the information in the Knowledge Base to either resolve 
the issue for the customer, or attach a list of the already contributed solutions to 
the service request or repair order.

Finding Service Requests and Repair Orders
Use the Repair Orders Search window to retrieve service requests or repair orders 
from the database.

Basic search in Oracle Depot Repair enables you to retrieve service requests and 
repair orders based on parameters related to a service request or repair order 
(number, customer, product, or date opened). You may use a combination of these 
parameters to restrict your search so as to retrieve only the service requests or repair 
orders you want.
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Prerequisites:
The service request or repair order record that you want to retrieve must exist in the 
database.

To find a service request or repair order:
1. From the Depot Repair Navigator, use the following path to open the Repair 

Orders Search window:

Depot Repair > Repair Orders

2. Select the parameters based on which you want to search for the service request 
or repair order.

The search parameters you can use include Customer Name, Number, Account 
Number, Service Request Number, Date Opened, Product, (product) Serial 
Number, Repair Order Number, and/or Sales/RMA Number.

3. Click Search to find matching service requests or repair orders based on the 
parameters you have specified.

4. The Results region in the Repair Orders Search window displays the search 
results. You can select any of the retrieved service requests or repair orders, and 
then click OK to view its details in the Repair Orders window.
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Creating and Maintaining Notes
Notes are used to record and manage the comments generated by the depot service 
agents and technicians against various services. Notes in a service request help in 
recording the descriptive information about customer repair issues, any progress 
done by an agent in resolving this issue etc. You can enter either Service Request or 
Repair Order notes from the Details tab in the Repair Orders window.

Prerequisites:
A repair order record must exist for a product before you can attach notes to the 
relevant service request or repair order.

To create and maintain notes:
1. Retrieve the service request or repair order to which you want to attach a note 

(see Finding Service Requests and Repair Orders).
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2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Details tab of the Repair Order window, select Service Request or Depot 
Repair in the Notes block as your need may be.

4. Click Notes to open the Notes window.

5. Select a note type in the Type field.

6. Select a note status in the Status field. The choices are Personal, Internal, and 
Publish. If you use the Personal status, this note would not be viewable to any 
customer in a customer facing application. Internal notes are viewable by 
employees at the depot. Publish notes are viewable by all employees and 
customers. You can create additional Status codes. Please refer to the CRM 
Foundation Implementation Guide for more information.

7. Enter a brief description of the note in the Note field.

8. If you want to enter more notes, click on the More button to open the Detailed 
Note window. You can enter additional text here. The Detailed Note window 
holds textual notes up to 32 K in size. Click OK after entering the detailed 
description.

9. To specify more details for the note, use the Related To and Value fields in the 
main Notes window.

10. Save the note. The note appears in the spreadtable under the Notes tab on the 
left. The Summary tab displays the notes as text in a chronological or reverse 
chronological manner. You can change the chronological view by clicking on the 
Latest First check box.

11. To search for existing notes, use the Find Notes functionality.

a. Open the Notes main window.

b. Click the flashlight icon on the toolbar to open the Find Notes window. 

c. Enter the fields such as Source, EnteredBy, etc.

d. Click Search to display the results.

Using the Knowledge Base
The Knowledge Base is a repository of solution sets that have already been 
contributed. The Knowledge Base system must be properly set up for this feature to 
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work. After logging a service request, you can search the Knowledge Base for 
possible solutions to diagnose and resolve the damage.

You can search the Knowledge Base using:

■ Keywords

■ Similar statements

■ Symptoms, causes, actions, or other defined knowledge statement types

■ Solution sets

Depot service agents and technicians can access the Knowledge Base throughout 
the depot repair process. Depot agents access the Knowledge Base for damage 
diagnosis, troubleshooting, estimate creation, and during the actual maintenance 
and testing. Agents with designated responsibilities can read, write, update, and 
delete items in the Knowledge Base.

Use the following procedure to create, search for, and update solutions in the 
Knowledge Base. You can also link Knowledge Base solutions to a selected repair 
order.

Prerequisites:
A service request must exist in order to search for, and attach Knowledge Base 
search results to a service request or repair order.

Procedure:
1. Retrieve the service request or repair order for which you want to search the 

Knowledge Base (see Finding Service Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and/or repair order details.

3. Select the Repair Estimate tab.

If estimate lines have been created for the selected repair order, the charge lines 
are displayed in the spreadtable below. If Knowledge Base solutions have 

Note: You cannot search the Knowledge Base for solutions based 
on the attached Service Codes. A statement will need to be created 
with the Service Code number or name in it to allow search.
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previously been attached to the repair order, the Knowledge Base Solutions 
block on the Repair Estimate tab lists the attached solutions.

4. To view the details of a Knowledge Base solution attached to the service request 
or repair order, select the solution line, and click Details. This launches the View 
Solution page. Click Update to update the linked solution as required.

5. In the Repair Estimate tab, enter the required field values. 

6. Click Search. This launches the HTML-based Knowledge Management 
Advanced Search page. The Product and Work Summary field values are 
passed by Oracle Depot Repair to the Knowledge Management Advanced 
Search screen.

7. Enter the search criteria in the fields provided. For detailed field descriptions, 
refer to the online help available from the screen, or refer to the Oracle 
Knowledge Management documentation.

8. Click Search to display the search results in the lower half of the screen. The 
Product and Work Summary data elements are passed to Knowledge 
Management with their respective Statement Types; Symptom, Cause, Action, 
or Fact, filtered based on the Solution Type.

9. To create a new solution in the Knowledge Base, click Create Object. This 
launches the Create Solution page. In the Solution Type field, select Repair 
Solution from the dropdown list. Based on solution type selected, applicable 
statement types (Symptom, Cause, Action, Fact) are defaulted for the depot. 
Click Add to associate the newly created object to the solution type. For 
detailed instructions, refer to online help, or to Oracle Knowledge Management 
documentation.

Please note that Oracle recommends you to link Service Codes to statements of 
type Fact. This is preferred over using your own seeded statement types.

10. To drilldown to a solution detail, on the Advanced Search screen, click the 
Description link corresponding to that solution. This launches the Solution 
Details page.

11. To link this Knowledge Base solution to the selected repair order, scroll down 
the Solution Details page, and click Yes in response to "Can this solve your 
problem?".
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Estimating Repair Charges
Depots may require to perform a repair diagnosis of the customer's returned 
product in order to accurately determine the cost involved in the actual repair, 
upgrade, or overhaul. The depot technician typically performs this by inspecting or 
performing a teardown of the product to determine the parts and labor that will be 
required for the repair. After completing this process, the depot provides a formal 
quotation to the customer for approval before any work is scheduled. During the 
teardown, the technician can identify individual parts, and diagnose for further 
service requirements using typical repair manuals and technical notes for aid.

To charge for repair services, a service provider can use standard pricing method 
using price lists to determine the fixed repair price. Variable pricing method can 
also be used, which permits the depot to charge the customer for the actual 
material, labor, and other expenses incurred during the repair. When exchanging or 
replacing products, a service provider typically calculates the price of the exchange 
as 60% of the new product price, and possession of the customer’s broken core 
product.

In Oracle Depot Repair, a repair order supports a single currency. The default 
currency is based on the default contract. If no default contract is selected, the 
default price list determines the currency. If neither defaults are set, the currency 
selection is based on the Price List manually selected from the List of Values in the 
Details tab. After a charge line is created, you cannot change the currency of the 
repair order in the Details tab, or select another default contract that has a price list 
of a different currency. To change the currency of a repair order, all the charge lines 
have to be deleted.

The repair order currency drives the list of price lists that you can use for estimate 
charge lines. You will not be able to select a price list with a currency that is 
different from the repair order currency.

Use the following procedure to prepare a repair charges estimate for the customer.

Note: If the system has been set up such as not to use the Estimate 
functionality, the Repair Estimate tab in the Repair Orders window 
will be disabled and you will not be able to create a repair estimate. 
For more information, see note in Repair Estimate Tab.
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Prerequisites:
All the steps in the relevant business scenario prior to creating the estimate must be 
completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To estimate charges for a repair:
1. Retrieve the repair order for which you want to estimate charges (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Repair Estimate tab in the Repair Orders window.

4. Enter the Status, Date, Lead Time, and UOM field values. For field descriptions, 
see Repair Estimate Tab.

5. Click Save Estimate to save the estimate header record.

6. Enter the individual charge line details in the spreadtable. For field 
descriptions, see  Repair Estimate Tab.

7. After entering a charge line, click Save Estimate to record the charge line. The 
system populates the Unit Price and Est Charge fields in the spreadtable. The 
Summary of Estimated Charges region is also populated. This region is updated 
as you add (or delete) charge lines.

8. Click Line Details to launch the Estimate Charge Details window. Enter the 
detailed charge line values in the spreadtable fields. See The Estimate Charge 
Details Worksheet for field descriptions.

9. To allow provision for overriding the entered charges later, select the Override 
Charges checkbox. This allows you to override repair charges once saved. 
However, note that you will not be able to apply a contract if you choose to 
override the charges.
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10. Click Save to record the changes.

11. Click Close to close the Estimate Charge Details window, and return to the 
Repair Estimate tab. The Totals fields at the bottom of the Repair Estimate tab 
are populated with charge line totals.

Note: If the repair is in WIP mode, the Submit Charges button on the Estimate 
Charge Line Details worksheet is enabled. If you have not already clicked Save 
to record the charge lines, clicking the Submit Charges button will record the 
charge lines, as well as interface these charge lines to Order Management. If you 
have already clicked Save, clicking the Submit Charges button will interface the 
recorded charge lines to Order Management.

In Tasks mode, however, the Submit Charges button is disabled on the Estimate 
Charge Line Details worksheet because the charge lines for tasks are created 
using the Tasks Debrief. The Submit Charges button is present on the Repair 
Tasks tab for Task mode repair types. Clicking this button after entering charges 
in the Debrief will interface these charge lines to Order Management.
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12. To delete a charge line, select the relevant charge line on the Repair Estimate 
tab, and click the Delete icon on the toolbar.

Note that you cannot add or delete charge lines in the Estimate Charge Details 
worksheet. You can add or delete charge lines only in the Repair Estimate tab.   

13. Click Apply Contract to apply any valid contracts to a transaction.

Note: If you had chosen to override charges, you will not be able to apply a 
contract.

Revising Repair Estimates
Certain repairs may require service providers to revise repair estimates many times. 
The service agent should check for existing warranties or contracts while quoting 
and revising estimates. Upon customer’s approval of the estimate, the depot 
receives the defective parts in repair sub inventory. If the customer rejects the 
estimate, the repair order is closed or put on hold as is appropriate. 

Use the following procedure to revise the estimated charges for a product under 
repair.

Prerequisites:
A repair charges estimate must exist for the damaged product.

To revise estimated charges:
1. Retrieve the repair order for which you want to revise the estimate (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Repair Estimate tab in the Repair Orders window. The existing charge 
lines are displayed in the multi-record block.

4. Click Estimate Detail. The Estimate Charge Line Details window opens.

Note: Repair charges may change after an estimate is created due 
to changes in currency conversion rates, or due to charge lines 
being added or deleted from an unfrozen estimate.
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5. Make the necessary changes to the charge line field values. See Estimating 
Repair Charges.

6. Click Save to record the revised charges.

7. Click Close to close the Estimate Charge Line Details window and return to the 
Repair Estimate tab. The charge lines and totals on the Estimate tab reflect the 
revision made to the estimate.

8. To change the repair estimate status, choose an appropriate value from the List 
of Values in the Status field.

9. Click the Save icon on the toolbar to record the changes.

Revising a Repair Order and Obtaining Customer Approval
After creating the repair charges estimate, the service agent seeks the customer’s 
approval of the estimate. Upon customer’s approval, the depot receives the 
defective parts in repair sub inventory. If the customer rejects the estimate, the 
repair order is closed, or put on hold as is appropriate.

Repair order estimates can be New, Drafted, Bid, Accepted, Rejected, or Cancelled. 
These statuses indicate whether to start a repair process. Typically, a repair estimate 
must be approved prior to the start of the repair job.

Use the following procedure to revise a repair order.

Prerequisites:
A repair order record with an approved estimate must exist. Also, you must have 
revised the original estimate as appropriate.

To revise a repair order:
1. Retrieve the repair order that you want to revise (see Finding Service Requests 

and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

The Details tab of the Repair Orders window displays the total charges for the 
repair in the Charges block.

3. Make changes to the original estimate charge lines as required. For detailed 
instructions, see Revising Repair Estimates.
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4. Discuss the revised charges with the customer.

5. In the Repair Estimate tab, update the estimate Status to Estimate Accepted or 
Estimate Rejected as is appropriate.

6. Click the Save icon on the toolbar to save the updated status. The repair order is 
revised with the new charges and customer approval information.

7. Using the Details tab, create or consult notes as required. For detailed 
instructions, see Creating and Maintaining Notes.

8. Click Update Status to launch the Update Status window. Use this window to 
update the repair order status depending on customer acceptance or rejection of 
the estimate. The repair order can remain Open, be on Hold, or Closed.

9. In the Repair Estimate tab, click Freeze Estimate to freeze the estimate. After 
being frozen, an estimate cannot be changed. 

For the WIP repair mode, the charges in the frozen estimate are used for 
invoicing. For the Tasks repair mode, the charges entered using the Tasks 
Debrief Report are used for invoicing.

Creating an RMA (Manually)
Using Oracle Depot Repair, depot agents can automatically create Sales Orders and 
RMA Orders while creating a repair order. This automation is based on the selected 
repair type, order type, repair mode, and service activity billing type attached to 
each repair type.

In scenarios where the RMA order is auto-created by the system, the system 
populates the RMA charge line in the Receive/Ship tab. The Enter Order radio 
button and the Automate order processing steps through and No Charge 
checkboxes are selected by default depending on Repair Type and Service Activities 
and Billing Types setup. The No Charge checkbox being selected indicates that the 
customer is not charged for the RMA transaction. If the Repair Type selected while 
creating the repair order is set to automatically interface the RMA line to Order 
Management, you cannot update this charge line. If the Repair Type has not been 
set to automatically interface charges to Order Management, you can update this 
charge line. Also, you cannot effect the No Charge flag after the order has been 
created. No Charge flag selection will take effect only based on its selection in the 
Service Activities and Billing Types setup. Refer to Oracle Depot Repair 
Implementation Manual for more information.
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Agents also have the option to create a Sales Order and RMA Order from the Depot 
Repair workbench manually. You can create an RMA manually using the 
Receive/Ship tab. For business scenarios where the RMA is auto-created, if you 
would rather create the RMA transaction manually, you can deselect the Auto-RMA 
checkbox before clicking the Save icon to create a repair order (see Creating a Repair 
Order).

The following procedure explains how you can create an RMA order manually.

Prerequisites:
All the steps in the relevant business scenario prior to creating an RMA must be 
completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To create an RMA manually:
1. Retrieve the repair order for which you want to create the RMA (see Finding 

Service Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Receive/Ship tab in the Repair Orders window.

For repair types that require RMA creation, the system auto-generates the RMA 
order based on repair type setup. But if you choose to process the transaction 
manually, deselect the Automatically Enter and Book RMA checkbox before 
saving the repair order. However, the RMA line is created and is displayed 
under the Receive/Ship tab. Refer to Creating a Repair Order.

Note: Oracle recommends that you do not use the Receive/Ship 
tab for charging RMA or Sales Order line items. Rather, use the 
Repair Estimate tab to enter these charge lines.
4-28 Oracle Depot Repair User Guide



Creating an RMA (Manually)
4. Select the Process Txn checkbox so as to process the RMA transaction.

5. Select or deselect, as desired, the Automate order processing steps through 
checkbox and the corresponding radio buttons. For more information and field 
descriptions, see  Receive/Ship Tab.

6. Click Process. The Order Num field is populated with the system generated 
RMA order number. If you had not selected the No Charge checkbox, the 
system returns the item price to the Price field based on Price List selected.

7. To delete an RMA or Sales Order line, select the RMA or Sales Order line on the 
Receive/Ship tab, and click the Delete icon on the toolbar.

Note: The Delete icon on the toolbar remains enabled as long as 
the RMA or Sales Order has not been submitted to Order 
Management (entered or booked). After the order is submitted to 
Order Management, the system disables the Delete icon, and you 
cannot delete the order line.
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Including RMA and Ship Lines on the Same Order
Oracle Depot Repair allows you to place all RMA, SHIP, and Estimate lines on the 
same order. You can also create a new order for an RMA or SHIP line by selecting 
the New Order checkbox on the Receive/Ship tab before interfacing the specified 
line to Order Management. Doing this adds the specified line to the new order. All 
subsequent lines will be added to the latest order created when they are interfaced 
to OM.

Estimate lines are not implicitly sent to Order Management. You must click Submit 
Charges to submit the estimate lines to Order Management. This is especially 
helpful when you have to submit charges multiple different times. Charges are 
submitted from the MLE (Material, Labor, Expense) lines on the Estimates tab in 
WIP repair mode, or from the MLE lines on the Debrief Report screen in Tasks 
repair mode.

Receiving a Broken Product
Depot Technicians can receive hand carried (walk-in) products for repair, or receive 
serviceable products against RMAs. Oracle Depot Repair provides flexible options 
when receiving and shipping products from and to customers and vendors.

Use the following procedure to receive a damaged product.

Prerequisites:
All the steps in the relevant business scenario prior to receiving a damaged product 
must be completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To receive a broken product:
1. Retrieve the repair order for which you want to receive the damaged product 

(see Finding Service Requests and Repair Orders).

Note: If you enter different Purchase Order numbers on different 
RMA or SHIP lines, then those lines will automatically be placed on 
different Sales Orders. Also, RMA and SHIP lines can only be 
added to the same order if the Order Type specified in Order 
Management is Mixed.
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2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Receive/Ship tab in the Repair Orders window. The application 
populates the Product, Product Description, UOM, and Qty fields in the 
Receive/Ship tabbed page. For detailed field descriptions, see Receive/Ship 
Tab.

4. Create an RMA order. For detailed instructions, see Creating an RMA Manually.

5. After the process transaction is complete, click Receive to open the Find 
Expected Receipts window.

6. In the Customer tab in the Find Expected Receipts window, enter the RMA 
Number, and click Find. If the RMA is found, the system launches the Receipt 
Header and Receipts windows.

7. In the Receiver field of the Service Request window, select the person receiving 
the RMA using the List of Values.

8. Confirm the Receiving Date, and click the Save icon on the toolbar to obtain the 
system generated Receipt Number.

9. Close the Receipt Header window.

10. In the Receipts window, in the Lines tab, select the checkbox located beside the 
Qty field to confirm quantity.

11. Use the horizontal scrollbar to reveal the Sub-inventory field. Select a 
Sub-inventory location in this field from the List of Values.

If the damaged product is serialized, the Lot-Serial button on the Receipts 
window is enabled.

a. Click Lot-Serial to launch the Serial Number window.

b. Enter the received Serial Number, and click OK. Note that you can 
manually enter a serial number here even if the number does not appear in 
the List of Values.

12. Click the Save icon on the toolbar to save the receipt record.

13. Close the Receipts window to return to the Repair Orders window.

14. From the Tools menu located on the toolbar, select Update Receiving.
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15. After the update Concurrent Request is completed, the Repair Activity tab in 
the Repair Orders window opens displaying the receipt transaction and 
quantity received.

You can monitor the progress of the transaction by selecting Requests from the 
View menu on the toolbar, and selecting appropriate search criteria.

Shipping Additional Items
Oracle Depot Repair performs a validation in the Receive/Ship tab to ensure that 
quantity of product on the repair order matches the RMA quantity on Receive/Ship 
tab. This implies that it is not possible to ship additional items or quantities of items 
against the same repair order. To ship additional items or quantities of items, you 
will need to create a new repair order with the additional item or quantity.

Managing the Repair Process
Oracle Depot Repair allows service organizations to manage repair using either 
Oracle WIP or Oracle Tasks. Oracle WIP mode is recommended for use when the 
repair jobs require series of sequential steps, and materials management. Tasks 
mode is recommended for use when the repairs require minimal steps that are not 
necessarily completed in sequence.

The WIP or Task modes are associated to the repair types during implementation. 
Though a service organization can have different repair types associated with 
different repair modes, it is recommended that a service organization select only 
one repair mode for all repair types to enhance usability.

For detailed procedures on using WIP and Tasks for managing repairs, see:

■ Creating a WIP Repair Job for a Single Repair Order

■ Processing a WIP Repair Job for a Single Repair Order

■ Creating a WIP Repair Job for Multiple Repair Orders

■ Processing a WIP Repair Job for Multiple Repair Orders

■ Creating Repair Tasks

■ Entering and Updating Task Details

■ Preparing the Repair Tasks Report
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Creating a WIP Repair Job for a Single Repair Order
The Shop Floor Technician can create a non-standard WIP job from the Depot 
Repair workbench. Multiple jobs can be created for each repair order. You can use 
the Release Jobs button to release repair jobs on to the shop floor. WIP Accounting 
Class must be provided through which costs are posted to Oracle General Ledger. 

The Repair Jobs search feature permits you to search for repair jobs issued for 
products that have already been received into the repair organization. You can 
perform the search against Repair Organization, Product Code, or attributes that 
pertain to the linked service request. The Repair Jobs Search window incorporates a 
multi-select feature to allow the user to select any or all Repair Order lines that were 
found in the search results.

Depot agents can view WIP Discrete Jobs window in a read only mode to check the 
status and additional details that are contained in the repair job.

Use the following procedure to create a WIP repair job for a single repair order. Also 
see Creating a WIP Repair Job for Multiple Repair Orders.

Prerequisites:
All the steps in the relevant business scenario prior to creating the WIP repair job 
must be completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To create a WIP repair job for a single repair order:
1. Retrieve the repair order for which you want to create a WIP repair job (see 

Finding Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

Note: You may need to create a Repair Job without an RMA in 
case of remanufacture or refurbishment on products already owned 
by your organization, or if your organization took ownership or 
possession of a product through a field service agent rather than 
against an RMA. Oracle Depot Repair provides you with a profile 
option, which if set appropriately, will allow you to create a WIP 
Repair Job without an RMA. Refer to Oracle Depot Repair 
Implementation Guide for details.
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3. In the Repair Orders window, select the Repair Jobs tab, and click Repair Job to 
launch the Organizations window.

4. Select the relevant repair organization, and click OK. The Repair Jobs window 
opens. For field descriptions, see Submit Repair Jobs Window.

5. If the WIP repair job product is different from the Repair Order product, select 
the relevant WIP product from the List of Values in the Product field.

6. Select Non Standard without Router in the Job Type field in the Repair Jobs 
header.

7. Select the Released Job Status from the List of Values.

8. Select an Accounting Class from the List of Values. For example, Rework.

9. Select a WIP Start Date and Complete Date.

10. Click Submit Job to submit the job in a released status to WIP.

11. To make sure that the program completes successfully, monitor the requests 
using the View menu on the toolbar (View > Requests).
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12. Close Repair Jobs window to return to the Repair Orders window.

13. From the Tools menu, run the Update Repair Job program. The new job will 
now appear on the Repair Jobs tab.

14. To view the job, select the job record on the Repair Jobs tab, and click View Job.

15. To process the WIP repair job, see Processing a WIP Repair Job for a Single 
Repair Order.

Processing a WIP Repair Job for a Single Repair Order
Perform the following steps to process a repair WIP job containing a single repair 
order.

Prerequisites:
All the steps in the relevant business scenario prior to processing the WIP repair job 
for the repair order must be completed. Refer to the discussion on scenarios in the 
chapter Depot Repair Business Scenarios.

To process a WIP repair job for a single repair order:
1. Retrieve the repair order for which you want to process the WIP repair job (see 

Finding Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Repair Orders window, select the Repair Jobs tab.

4. Click Material Txn to launch the Material Transaction window.

5. Issue the damaged product and the material required to process the repair job.

6. Complete the product repair using a recommended repair procedure.

7. After the repair is completed, click Complete Job on the Repair Jobs tab to 
launch the Completion Transaction Find window.

8. Enter the WIP Job Number, and click Continue to launch the Completions 
Transaction window.

9. Enter the WIP job completed Qty.

If using the Oracle Quality module, from the Tools menu, select and launch the 
Quality results window.
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10. Confirm the Completion Sub-inventory location, and click Done to save the 
record.

11. Close the remaining windows to return to the Repair Orders window.

12. Move the repaired product to the specified Completion Sub-inventory location.

13. From the Tools menu, select Update Repair Job to update the repair order 
activities. The Activity tab of the Repair Orders window displays the updated 
information.

14. From the Repair Estimate tab of the Repair Orders window, click Estimate 
Detail to launch the Estimate Charge Line Details window.

15. Create or modify charge lines for material, labor, and other expenses incurred 
during the repair.

16. Select a Price List, apply contract entitlements, and then submit charge lines to 
Order Management to add these charges to the order. For detailed instructions, 
see Estimating Repair Charges.

17. After all the expenses incurred during the repair is recorded, return to the 
Repair Estimate tab, and click Freeze Estimate to freeze the estimate. The 
customer invoice is prepared based on this frozen estimate.

Creating a WIP Repair Job for Multiple Repair Orders
Oracle Depot Repair allows service organizations to auto-create a single repair job 
against multiple repair orders for identical products.

Use the following procedure to create a WIP repair job for multiple repair orders 
relating to the same product. Also see Creating a WIP Repair Job for a Single Repair 
Order.

Prerequisites:
All the steps in the relevant business scenario prior to creating the WIP repair job 
for the repair orders must be completed. Refer to the discussion on scenarios in the 
chapter Depot Repair Business Scenarios.

To create a WIP repair job for multiple repair orders:
1. From the Depot Repair Navigator, use the following path to open the 

Organizations window:

Depot Repair > Submit Repair Jobs
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2. Select the relevant Repair Organization from the List of Values. The Repair Jobs 
Search window opens.

3. Enter one or more of the following search criteria. For field descriptions, see 
Repair Jobs Search Window.

■ Product

■ Promise Date or Date Range

■ Creation Date or Date Range

■ Customer Name

■ Service Request Number

■ Customer Number

■ Severity or Urgency
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4. Click Search to start the query. The search results appear in the Results block of 
the Repair Jobs Search window.

5. Select the relevant repair job. To select a row, hold down the Control key and 
click the left mouse button. This will highlight the row. To select multiple rows, 
hold down shift, and click the left mouse button.

6. After you select the relevant rows, click OK to launch the Submit Repair Jobs 
window. The selected rows populate the Repair Order Information block in the 
window, and the Total Quantity Submitted for repair is automatically 
populated. For field descriptions, see Submit Repair Jobs Window.

7. In the Repair Jobs Parameters block of the Submit Repair Jobs window, select 
the Job Type: Non Standard without Router.

8. In the Job Status field, select Released from the dropdown list. The Job Status 
values in the dropdown list are decided by your organization while setting up 
Oracle Depot Repair.

9. Select an Accounting Class from the List of Values. For example, Rework. These 
values are set up by your organization while implementing Oracle Depot 
Repair.

10. Select WIP Start and Complete Dates.

11. Click Submit Job to submit the job in a released status to WIP.

12. To make sure that the program completes successfully, monitor the requests 
using the View menu on the toolbar (View > Requests).

13. Close the Submit Repair Jobs window and return to the Navigator.

14. Retrieve these repair orders using the Repair Orders Search window.

15. In the Repair Orders window, select each repair order, and from the Tools 
menu, run the Update Repair Job program. The new job will now appear on the 
Repair Jobs tab. Also see Updating Repair Orders Concurrently.

16. Then, proceed to process the WIP repair job. See Processing a WIP Repair Job 
for Multiple Repair Orders.

Processing a WIP Repair Job for Multiple Repair Orders
Perform the following tasks to process a WIP repair job containing multiple Repair 
Orders.
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Prerequisites:
All the steps in the relevant business scenario prior to processing the WIP repair job 
for the repair orders must be completed. Refer to the discussion on scenarios in the 
chapter Depot Repair Business Scenarios.

To process a WIP repair job:
1. From the Depot Repair Navigator, use the following navigation path to launch 

the Jobs Find window:

WIP > Discrete > Discrete Jobs.

2. Optionally, print shop paper for items such as the router, the move tickets, and 
the parts list.

3. Enter the WIP Repair Job Number, then click the Find Button to launch the 
Discrete Jobs window.

4. Confirm that the Repair Job is in Released status.

5. Click the Routing Tab and select the Completion Sub-Inventory from the LOV 
dropdown list.

6. If the item is under Locator control, enter the Locator value.

7. Save your work.

8. Close the Discrete Jobs window to return to the navigator.

9. From the Navigator, use the following path to launch the WIP Material 
Transaction Find window:

WIP > Material Transactions > WIP Material Transactions.

10. Select the Specific Component radio button if the material to be issued is not 
defined as a material requirement for the job.

11. Enter the WIP Job Number then click the Continue Button to launch the WIP 
Component Issue window.

12. Enter the Items to be repaired in the Components Issue window.

Note: If you did not select the Specific Component radio button, and the 
material you want to issue is not defined as a material requirement for the job, 
you may not be able to issue the item.

13. Select the present Sub-Inventory location of the broken items.

14. If the items are Locator controlled, enter Locator information.
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15. Enter the Quantity to be repaired.

16. If the items are under Serial or Lot control, enter Serial or Lot information.

17. Enter the material needed to facilitate the repair.

18. Click Done. This issues the material and closes the window.

19. Close the WIP Material Transaction window to return to the navigator.

20. After completing the repair, from the Navigator, use the following path to 
launch the Completion Transaction window:

WIP > Material Transactions > Completion Transactions.

21. Enter the WIP Repair Job Number, and click the Continue Button.

22. Enter the completed quantity and the completion subinventory (if not entered 
earlier).

23. If the items are Locator, Serial, or Lot controlled, and you entered such 
information earlier, enter these values now.

24. Click Done to perform the completion transaction and return to the Depot 
Repair Navigator window.

25. From the Navigator, use the following path to launch the Find WIP Jobs and 
Schedules window:

WIP > Discrete > WIP Value Summary.

26. Enter the WIP Repair Job Number, and click Find to launch the WIP Jobs and 
Schedules window.

27. Enter the From Period and To Period information.

28. Click Value Summary to launch the WIP Summary window.

29. On the Repair Estimate tab, click Estimate Detail to launch the Estimate Charge 
Line Details window.

30. Create or modify charge lines for material, labor, and other expenses.

31. Select a Price List, apply contract entitlements, and then submit charge lines to 
Order Management to add these charges to the order. For detailed instructions, 
see Estimating Repair Charges.

32. After all the expenses incurred during the repair is recorded, return to the 
Repair Estimate tab, and click Freeze Estimate to freeze the estimate. The 
customer invoice is prepared based on this frozen estimate.
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Creating Multiple WIP Repair Jobs for a Single Repair Order
Oracle Depot Repair allows you to create multiple WIP jobs for a single repair order, 
and supports the creation of multiple WIP jobs with partial quantities per RMA.

If the product selected for the WIP job is the same as the one in the repair order, 
then for each WIP job submission, the submit quantity cannot be greater than the 
quantity received. A submit quantity less than the quantity received implies that 
you can create multiple WIP jobs against a single repair order, with each WIP job 
handling part of the RMA quantity. 

For example, consider that the product on the repair order is A, and the quantity of 
product A is 5. When you submit WIP jobs for product A, the maximum number of 
units of A that can be submitted in a WIP job is 5, and the minimum is 1.

However, the quantity submitted to WIP can be greater than the quantity received. 
If the product selected for a WIP job is different from the one on the repair order, the 
submit quantity restriction will not apply, and you can submit the WIP job for any 
quantity. The system validates this quantity with the quantity received in the repair 
order line. In this case, the quantity to be submitted to WIP must be at least 1.

Creating Repair Tasks
Tasks consist of work assignments that detail the actions required of company 
personnel.

The Repair Tasks tab in the Repair Orders window provides a solution for repair 
establishments that use simple, standard business processes without requirements 
for WIP-based processes. The Tasks module is accessed (Repair Tasks tab is enabled 
or disabled) depending on the repair type selected in the Repair Orders window 
Details tab.

In the Repair Tasks tab, you can create, update, assign, and view previous tasks 
assigned to a repair order. Tasks assigned previously are listed in the spreadtable at 
the top of the tab, while details of the selected task are displayed in the fields below 
it. You can create a task directly from the Repair Tasks tab by entering all the 
relevant information, or by using a template.

See:

■ Creating Repair Tasks Manually

■ Creating a Repair Task Using the Task Template
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Creating a Repair Task Manually
Perform the following steps to create a repair task manually.

Prerequisites
All the steps in the relevant business scenario prior to creating the repair tasks for 
the repair order must be completed. Refer to the chapter Depot Repair Business 
Scenarios.

To create a repair task manually:
1. Retrieve the repair order for which you want to create repair tasks (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Repair Orders window, select the Repair Tasks tab. If tasks have already 
been defined for the repair order, the spreadtable lists the tasks. If more than 
one task is displayed, selecting a different task will display the corresponding 
detail in the lower fields on the tab.
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4. Enter the task information in the required fields using the List of Values. For 
field descriptions, see The Repair Tasks Tab.

5. Enter the values in the Assignee and Owner fields (or change them) by selecting 
from the list of values. You can also change these field values by using the 
Assignment Manager. To access the Assignment Manager, click the Assignment 
Manager button next to the fields. For additional information about the 
Assignment Engine, refer to Oracle CRM Foundation Concepts and Procedures.

6. Select the Planned Start and End Dates.

7. Click the Save icon on the toolbar to save the task record. A system generated 
task number populates the Num field.

8. To manually launch workflow, select the task from the spreadtable, and click 
Launch Workflow. The workflow is launched based on the task. The designated 
resources are reserved, and the workflow notifies the task owner of task 
creation through email.
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Note: The Launch Workflow button is enabled only if resources have been 
assigned to the selected task.

9. To add or update task details, click More. This launches the Task Details 
window. For more information, see Entering and Updating Task Details.

Creating a Repair Task Using the Task Template
Use the following procedure to create a repair task using the task template.

Prerequisites
All the steps in the relevant business scenario prior to creating the repair tasks for 
the repair order must be completed. Refer to the chapter Depot Repair Business 
Scenarios. Before you create a task from a template, a template design must exist.

To create a repair task using a task template:
1. Retrieve the repair order for which you want to create repair tasks (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Repair Orders window, select the Repair Tasks tab. If tasks have already 
been defined for the repair order, the spreadtable lists the tasks. If more than 
one task is displayed, selecting a different task will display the corresponding 
detail in the lower fields on the tab.

4. Click Use Template in the Repair Tasks tab. The Create Tasks from Template 
Group window opens.

5. In the Template Group field, select the template group based on the task which 
is to be created. Values in the Source Document, Source Name, Owner Type and 
Owner fields are defaulted. You may change these values, if needed.
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6. Click Create Tasks. You are returned to the Repair Tasks tab with a new task line 
identified by a system generated task number in the Num field.

7. To manually launch workflow, click Launch Workflow. The workflow is 
launched based on the task. The designated resources are reserved, and the 
workflow notifies the task owner of task creation through email.

Note: The Launch Workflow button is enabled only if a resource has been 
assigned to a selected task.

8. Click More to open the Task Details window to enter details such as resource 
assignments, dependencies, references, and contacts. For details, see Entering 
and Updating Task Details.

Entering and Updating Task Details
After a task record is created, you can update task information and task details. Use 
the following procedure to update task information and to add task details.
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Prerequisites:
Task records that you want to update or add details to must exist in the database.

To update task details:
1. Retrieve the repair order for which you want to update task details (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Repair Orders window, select the Repair Tasks tab. If tasks have already 
been defined for the repair order, the spreadtable lists the tasks. If more than 
one task is displayed, selecting a different task will display the corresponding 
detail in the lower section of the screen.

4. To update basic task information, make the necessary changes to the field 
values, and click the Save icon on the toolbar. For field descriptions, see Repair 
Tasks Tab.

5. To specify task details, select the task for which you want to update details, and 
click More. This launches the Task Details window. The Task Details window 
comprises the following tabs:

■ Resources: Use this tab to assign personnel information to a task. This tab 
defines resource requirements, assignments, and scheduling information.

■ Dependencies: This tab helps determine the order of tasks. Oracle Depot 
Repair, however, does not enforce task dependencies.

■ References: Use the References tab to link the task to different documents or 
tasks with pertinent background information.

■ Dates: Use the Dates tab to identify more dates in addition to the planned 
dates, the scheduled dates, and the actual dates. You can use this tab to 
track task progress by entering dates after task milestones such as task 
creation, resource reservation, or task completion.

■ Contacts: Use this tab to create and manage multiple contacts assigned to a 
task. Contact information is obtained from customer information. To enter 
this information, you must identify a customer in the main task window.

■ Recurrences: Use this tab to schedule tasks so as to occur automatically. 
Examples of intervals include daily, weekly, monthly, or yearly occurrences. 
To schedule recurring tasks, you must either specify a start date and the 
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number of tasks to create, or the end date. The task dates are populated as 
the planned start and end dates. 

■ Others: Use the Others tab to identify additional information about the task, 
and select different configurations for each task. Setting flags customizes 
each task according to business needs.

■ Audit: Use the Audit tab to track each update to a task. The tab documents 
and dates the history of task change, and provides a trail from the original 
task through to the current task status.

6. Enter the field values on the different tabs as required. For detailed instructions 
refer to Using Task Manager, Oracle CRM Application Foundation Concepts and 
Procedures.

7. Click OK to save your work and return to the Repair Tasks tab in the Repair 
Orders window.
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Preparing the Repair Tasks Debrief
The Repair Tasks tab allows you to initiate the Debrief button that launches 
Material, Labor, and Expense forms, enabling you to debrief a job with actual 
material, labor, and expense charges incurred during the repair.

For repair jobs managed using Tasks, the Debrief provides the actual charges 
incurred during the repair that would be invoiced to a customer. If both estimate 
and debrief exists for a repair managed using Tasks, the customer is invoiced based 
on charges listed in the debrief.

Use the following procedure to create the Debrief. This procedure is applicable only 
to repair processes managed using Tasks.

Prerequisites:
All the steps in the relevant business scenario prior to creating the repair tasks for 
the repair order must be completed. Refer to the chapter Depot Repair Business 
Scenarios.

To prepare the Repair Tasks Debrief:
1. Retrieve the repair order for which you want to update task details (see Finding 

Service Requests and Repair Orders).

2. Select the relevant record from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Repair Orders window, select the Repair Tasks tab. If tasks have already 
been defined for the repair order, the spreadtable lists the tasks. If more than 
one task is displayed, selecting a different task will display the corresponding 
detail in the lower section of the screen.

4. Select the task for which you want to create the report, and click Debrief. This 
launches the Debrief Report window with the selected task details populated in 
the fields at the top of the screen. The lower half of the window comprises the 
Material, Expense, and Labor tabs.
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5. Select the Material tab to enter details of material transactions during the repair 
task.

6. Select the Expense tab to enter details of other expenses incurred during the 
repair task.

7. Select the Labor tab to enter labor transaction details that were required for the 
repair task.

8. Click Update to save the details.

For detailed instructions and discussion on buttons and checkboxes accessible 
from the Debrief Report window, refer to Oracle Field Service Concepts and 
Procedures. You can also use the online help available from this window.

Note that in Tasks mode, Debrief lines do not support the application of 
contracts per charge line. If you are using Depot debrief to generate charges, the 
contract at the service request level is automatically applied to the charge lines.
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9. To interface the charge lines entered in the tasks report to Order Management, 
return to the Repair Tasks tab on the Repair Orders window, select the relevant 
task, and click Submit Charges.

Viewing Activities Related to a Repair Order
The Activity tab displays a real-time view of events and activities that surround a 
repair order. This permits the depot agents and planners to know the exact status of 
each repair order line.   

Use the following procedure to view the activities that have elapsed at the depot in 
association with a repair order.

To view activities related to a repair order:
1. Retrieve the repair order for which you want to view the elapsed depot 

activities (see Finding Service Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Activity tab of the Repair Orders window. The tab displays the 
quantity received, quantity submitted to WIP, quantity completed in WIP, and 
quantity shipped. It also displays individual events, event dates, quantity, and 
other details. For detailed field descriptions, see Activity Tab.

Note: The fields, Quantity Submitted to WIP and Quantity 
Completed in WIP, appear only for repairs processed in WIP mode.
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4. If the Activity tab does not display updated information, select the relevant 
repair order, and run the Update Receiving, Update Repair Job, and Update 
Shipping programs from the Tools Menu. This will update the quantity 
received, quantity submitted to WIP and quantity completed in WIP, and the 
quantity shipped respectively.

See Updating Repair Orders Concurrently.

Updating Repair Orders Concurrently
If you would like to update all the open repair orders at the same time, please use 
the following concurrent programs:

■ Depot Repair Job (WIP) Update

Note: The Update Receiving, Update Repair Job, and Update 
Shipping programs available from the Tools menu on the Depot 
Repair Workbench executes the update only for the Repair Order 
currently selected in the Workbench.
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■ Depot Repair RMA Receipt Update

■ Depot Repair Shipment Update

To access these programs, from the Depot Repair Navigator, use the following path:

Depot Repair > Other > Run Requests.

This launches the Submit a New Request window, where you can choose to submit 
a Single Request. This launches the Submit Request window. In the Name field, 
select the program that you want to run (Depot Repair RMA Receipt Update, Depot 
Repair Job (WIP) Update, or Depot Repair Shipment Update, to update quantity 
received, quantity submitted to or completed in WIP, and quantity shipped 
respectively, for all open repair orders).

Use the remaining window fields to schedule the program to run at times or 
intervals of your choice, to choose who to notify on completion, and to choose 
whether to print and/or save the reports. For more information, refer to the online 
help available from these windows.

Note that the Depot Repair Update Receiving Concurrent Program picks only the 
receiving lines that are delivered to a subinventory. This is to support business 
scenarios that involve quantity correction of goods received at the dock.

For example, during the inspection of goods received at a dock, you may want to 
correct or return some quantity of the goods delivered. This could be because not as 
many items were sent as the customer said they would, or the customer returned 
more than expected, such as, goods that were too damaged to qualify for a refund, 
or goods that were not sold by your organization. Items are not considered as 
received until they pass the inspection, and are delivered to a subinventory. Only at 
this point does the Depot Repair Update Receiving Concurrent Program stamp the 
received quantity, and the user interface reflects the change in the received quantity.

Workflow-Based Messaging
At a high level, the Workflow-based Messaging functionality provides the ability to 
send a workflow notification message, and have that message link to the Repair 
Order selected in the Depot Repair Workbench at the time the message was sent. 
Messages can be of various types, from information-only to those that request 
actions or approvals from others. When the message recipient responds to the 
message linked to the specified Repair Order, that response is captured in the 
Repair Order's message history. A message can be sent to one or many recipients, 
and can be sent to group lists. Messages sent to multiple recipients can only be 
informational messages.
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In Oracle Depot Repair, messages are tied to a repair order, and are sent from the 
Repair Orders form.

For more information on message types, sending, receiving, and viewing messages, 
and user procedures, please refer to Oracle Support User Guide and Oracle Support 
Implementation Guide.

Entering Final Charges and Creating the Shipment
Use the following procedure to enter the final charges after repair, and to create a 
shipment.
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Prerequisites:
All the steps in the relevant business scenario prior to entering the final charges and 
creating the shipment must be completed. Refer to the discussion on scenarios in 
the chapter Depot Repair Business Scenarios.

To enter the final charges and create a shipment:
1. Retrieve the repair order for which you want to enter the final charges and 

create the shipment (see Finding Service Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. If using the WIP repair mode, ensure that all relevant charges are entered in the 
Repair Estimate tab. See Estimating Repair Charges for details.

If using the Tasks repair mode, ensure that all relevant charges are entered in 
the Depot Debrief in the Repair Tasks tab.

Note: Depot Debrief does not allow you to apply contracts per charge line. If 
you are using Depot Debrief to generate charges, the contract at the service 
request level is automatically applied to the charge line.

4. Select the Receive/Ship tab in the Repair Orders window.

5. In the Action Type field, select SHIP.

6. Select the Action Code and Billing Type. For detailed field descriptions, see 
Receive/Ship Tab.

7. Select the pricing method as applicable in the Pricing List field.

8. Select the Process Txn (transaction) checkbox.

9. Select the Automate Order Processing Steps through checkbox and the radio 
button options Book Order, and Pick Release.

Note: Tax, Shipping, and Freight charges are not calculated within 
Oracle Depot Repair, but are calculated in Order management 
when orders are interfaced to Order Management. For this reason, 
the charge totals in the Repair Estimate tab and on the Tasks 
Debrief may be different from the value charged on the invoice.
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10. Click Process. This creates, books, and releases the Sales Order. The application 
populates the Order Number, Order Status, Bill-To, and Ship-To fields. You can 
monitor the order status from the Status field.

11. If the product record exists in the Install Base, you can view the Install Base 
transaction details using the IB Txn Details button on the Receive/Ship tab.

Shipping an Item
Depending on the business scenario, a product being shipped may or may not be 
repaired. Shipments may include repaired, replacement, loan, or exchange items. 
Use the following procedure to ship a product to the customer.

Prerequisites:
All the steps in the relevant business scenario prior to shipping an item must be 
completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To ship an item:
1. Retrieve the repair order for the product that you want to ship (see Finding 

Service Requests and Repair Orders).

2. Select the relevant order from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Select the Receive/Ship tab of the Repair Orders window.

4. Select the SHIP transaction line, the Process Transaction checkbox, and the Ship 
Confirm radio button with the Automate Order Processing steps through 
checkbox selected.

Note that the Serial Number field for serialized items may or may not be 
mandatory depending upon profile option setup during implementation. If the 
Serial Number field is not mandatory, you cannot automate the shipping 
process directly from the Depot Repair Workbench. Instead, launch the 
Shipping forms and enter the Serial Number before attempting to ship. If the 
item to be shipped is serialized and the serial number has not been entered, the 
Ship Order checkbox will remain disabled.

5. Click Process. 
Managing Depot Business Processes 4-55



Invoicing a Customer
Note that after a Receive/Ship line has been interfaced to Order Management, 
that line (including the serial number field) cannot be updated. 

6. From the Tools menu, select Update Shipping program.

7. From the View menu, select Requests and enter appropriate search criteria to 
monitor the progress of the transaction. When the transaction is completed, the 
Activity tab will display the quantity shipped.

Invoicing a Customer
Follow the procedure below to invoice a customer.

Prerequisites:
All the steps in the relevant business scenario prior to invoicing a customer for the 
repair must be completed. Refer to the discussion on scenarios in the chapter Depot 
Repair Business Scenarios.

To invoice a customer:
1. Navigate to Accounts Receivable.

2. Invoice the customer using normal business procedures. For more information, 
refer to Oracle Receivables User Guide.

3. After the invoice cycle is completed, you can view the Invoice Number and 
Invoice Date for a particular charge line on the Others tab of the Charges 
window. The Charges window is accessible from the Details tab of the Repair 
Orders window. 

Closing a Repair Order
Perform the following tasks to close a repair order.

Prerequisites:
All the steps in the relevant business scenario prior to closing the repair order must 
be completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To close a repair order:
1. Retrieve the repair order for the product that you want to ship (see Finding 

Service Requests and Repair Orders).
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2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. Confirm that the quantity on the repair order is complete.

4. Consult or create notes if necessary. For detailed instructions, see Creating and 
Maintaining Notes.

5. In the Details tab of the Repair Orders window, click Update Status. The Update 
Status window opens. Also see Update Status Button.

6. Select Close using the radial button, and click OK to close the repair order line.

You can use a Reason Code from the List of Values, and enter additional details 
supporting the status update.

7. Click the Save icon on the toolbar to save the record.

Closing a Service Request
You can close a service request using the following procedure.

Prerequisites:
All the steps in the relevant business scenario prior to closing the service request 
must be completed. Refer to the discussion on scenarios in the chapter Depot Repair 
Business Scenarios.

To close a service request:
1. Retrieve the service request that you want to close (see Finding Service 

Requests and Repair Orders).

2. Select the relevant result from the Results block of the Repair Orders Search 
window, and click OK. This launches the Repair Orders window populated 
with the selected service request and repair order details.

3. In the Service Request Information block of the Repair Orders window, change 
the status of the service request to Closed using the dropdown list. Also enter 
the date closed.

4. If required, create notes stating the reason for the service request closure. See 
Creating and Maintaining Notes for detailed instructions.

5. Click the Save icon on the toolbar to close the service request.
Managing Depot Business Processes 4-57



Closing a Service Request
4-58 Oracle Depot Repair User Guide


	Contents
	Send Us Your Comments
	Preface
	Intended Audience
	How To Use This Guide
	Documentation Accessibility
	Other Information Sources
	Do Not Use Database Tools to Modify Oracle Applications Data
	About Oracle

	1 Introduction to Oracle Depot Repair
	What is Oracle Depot Repair?
	Oracle Depot Repair Key Features
	Customer Management
	Service Request Management
	Repair Type Processing
	Repair Job Management
	Repair Resolution Management

	Business Process Flows
	Logistics and Maintenance with Call Center Facility
	Logistics and Maintenance without Call Center Facility
	Internal Repairs

	Integration with Other Oracle Modules

	2 Overview of Using Oracle Depot Repair
	Accessing Oracle Depot Repair
	The Depot Repair Workbench
	The Service Request Information Block
	The Repair Order Information Block
	Tabs in the Repair Orders Window
	Details Tab
	Receive/Ship Tab
	Repair Estimate Tab
	Repair Jobs Tab
	Repair Tasks Tab
	Activity Tab
	Service History Tab
	Product Coverage Tab

	Repair Orders Window Tools Menu
	Repair Jobs Search Window
	Submit Repair Jobs Window

	3 Depot Repair Business Scenarios
	Processing a Repair and Return
	Processing a Loaner, Repair and Return
	Processing an Exchange
	Processing an Advanced Exchange
	Processing a Replacement

	4 Managing Depot Business Processes
	Viewing Customer Profile
	Viewing Product Coverage Information
	Viewing Product Service History
	Creating a Customer Contact
	Creating a Service Request
	Creating a Repair Order
	Finding Service Requests and Repair Orders
	Creating and Maintaining Notes
	Using the Knowledge Base
	Estimating Repair Charges
	Revising Repair Estimates
	Revising a Repair Order and Obtaining Customer Approval
	Creating an RMA (Manually)
	Including RMA and Ship Lines on the Same Order
	Receiving a Broken Product
	Shipping Additional Items
	Managing the Repair Process
	Creating a WIP Repair Job for a Single Repair Order
	Processing a WIP Repair Job for a Single Repair Order
	Creating a WIP Repair Job for Multiple Repair Orders
	Processing a WIP Repair Job for Multiple Repair Orders
	Creating Multiple WIP Repair Jobs for a Single Repair Order
	Creating Repair Tasks
	Creating a Repair Task Manually
	Creating a Repair Task Using the Task Template

	Entering and Updating Task Details
	Preparing the Repair Tasks Debrief
	Viewing Activities Related to a Repair Order
	Updating Repair Orders Concurrently
	Workflow-Based Messaging
	Entering Final Charges and Creating the Shipment
	Shipping an Item
	Invoicing a Customer
	Closing a Repair Order
	Closing a Service Request


